Trademarks

1 Step RoboPDF, ActiveEdit, ActiveTest, Authorware, Blue Sky Software, Blue Sky, Breeze, Breezo, Captivate, Central, ColdFusion, Contribute, Database Explorer, Director, Dreamweaver, Fireworks, Flash, FlashCast, FlashHelp, Flash Lite, FlashPaper, Flex, Flex Builder, Fontographer, FreeHand, Generator, HomeSite, JRun, MacRecorder, Macromedia, MXML, RoboEngine, RoboHelp, RoboInfo, RoboPDF, Roundtrip, Roundtrip HTML, Shockwave, SoundEdit, Studio MX, UltraDev, and WebHelp are either registered trademarks or trademarks of Macromedia, Inc. and may be registered in the United States or in other jurisdictions including internationally. Other product names, logos, designs, titles, words, or phrases mentioned within this publication may be trademarks, service marks, or trade names of Macromedia, Inc. or other entities and may be registered in certain jurisdictions including internationally.

Third-Party Information

This guide contains links to third-party websites that are not under the control of Macromedia, and Macromedia is not responsible for the content on any linked site. If you access a third-party website mentioned in this guide, then you do so at your own risk. Macromedia provides these links only as a convenience, and the inclusion of the link does not imply that Macromedia endorses or accepts any responsibility for the content on those third-party sites.

This software is based in part on the work of the Independent JPEG Group.

LAME (MP3 encoder) Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels), streaming applications (via Internet, intranets and/or other networks), other content distribution systems (pay-audio or audio-on-demand application sand the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards and the like. An independent license for such use is required. For details, please visit: http://mp3licensing.com.

Copyright © 2001-2005 Macromedia, Inc. All rights reserved. This manual may not be copied, photocopied, reproduced, translated, or converted to any electronic or machine-readable form in whole or in part without written approval from Macromedia, Inc. Notwithstanding the foregoing, the owner or authorized user of a valid copy of the software with which this manual was provided may print out one copy of this manual from an electronic version of this manual for the sole purpose of such owner or authorized user learning to use such software, provided that no part of this manual may be printed out, reproduced, distributed, resold, or transmitted for any other purposes, including, without limitation, commercial purposes, such as selling copies of this documentation or providing paid-for support services.

Acknowledgments

Writing: Suzanne Smith
Editing: Lisa Stanziano, Anne Szabla, and Mark Nigara
Media Design and Production: Adam Barnett, John Francis, Aaron Begley, and Mario Reynoso
Special thanks to Erick Vera, Stephanie Gowin, Patrice O’Neil, Rosana Francescato, Pauly Matthews, Tim Wood, Tracy Seibel, Cecil Kift, Robert Thompson, David Yun, John Falcon, and the entire Breeze Presenter engineering and QA teams.

Second Edition: August 2005

Macromedia, Inc.
601 Townsend St.
San Francisco, CA 94103
Using the Audio Editor ............................................. 38
Setting audio quality for a presentation ......................... 39
Previewing audio ...................................................... 40

CHAPTER 4: Adding Quizzes ......................................... 41
About creating quizzes and questions ............................... 42
About branching in Breeze Presenter presentations .............. 43
Creating quizzes and questions ..................................... 43
Changing question slide order ...................................... 61
Deleting question slides ............................................. 61
Setting reporting options .......................................... 61
Setting an e-learning pass rate for a quiz ......................... 63
Using feedback messages in quizzes and questions ............... 64
About using Breeze Presenter presentations with a learning management system ... 65

CHAPTER 5: Designing the Presentation Experience ............... 69
Working with themes in presentations ............................. 69
Using PowerPoint templates for Breeze Presenter ............... 76
Adding a logo ......................................................... 77
Including slide notes in presentations ............................. 78
Automatically playing a presentation ............................... 80
Looping a presentation ............................................. 81
Changing slide display timing ...................................... 81

CHAPTER 6: Working with Breeze Servers ......................... 83
About Macromedia Breeze .......................................... 83
Accessing your Breeze account .................................... 84
Managing the Breeze server publishing list ....................... 84
Publishing to a Macromedia Breeze server ....................... 86
Adding a Breeze Presenter presentation to a Breeze meeting .. 89
Viewing a presentation in a Breeze meeting ..................... 91
Viewing a presentation in Breeze Training ....................... 97
Using presentations with Breeze Events .......................... 97
Using presentations with third-party learning management systems (LMS) .......... 98

CHAPTER 7: Troubleshooting .......................................... 99
Optimizing Flash (SWF) files ..................................... 99
Controlling inserted SWF files .................................. 99

INDEX .................................................................. 101
Macromedia Breeze Presenter has 10 demonstrations that you can watch to learn how to do important tasks. The demonstrations are short, about 1-2 minutes in length, and show tasks such as creating a new presentation, adding audio, and publishing a presentation to a Breeze server.

Open the Quick Start Guide.
Macromedia Breeze Presenter is a software tool for creating e-learning content and high-quality multimedia presentations rapidly. Breeze Presenter uses Microsoft PowerPoint, a popular application that is part of the Microsoft Office suite, as a base. Finished presentations are in Flash format (SWF file) and are SCORM and AICC compliant.

Breeze Presenter is an excellent complement to Macromedia Breeze. You can create content that includes interactive quizzing and surveys, audio, and a customizable viewer with Breeze Presenter. Breeze Presenter sends the PowerPoint (PPT) and Pocket PC (PPC) files, as well as presentation data, to the Breeze server. Then, you can simply log on to the Breeze server and, using Breeze Manager, complete the publishing process by selecting permission and folder options.

You can add straightforward or sophisticated quizzes to presentations. Breeze Presenter supports six different types of questions that can either be graded or used as surveys. You can use branching to guide users through different paths in the presentation based on their answers to quizzes.

Breeze Presenter provides a simple interface for using a microphone to add audio narration to your presentation. In addition, you can easily synchronize your PowerPoint animations with your audio narration.

The Breeze Presenter intuitive interface and its complete integration with PowerPoint eliminates the need for additional training or Flash programming. In minutes, you can transform static PowerPoint files into dynamic web experiences by adding audio, video, multimedia, interactive quizzes and surveys, and extensive branding. When you have created your content, simply publish it to a Breeze server.

After you have installed Breeze Presenter, you access the program from within PowerPoint. When you open PowerPoint, a new menu named “Breeze” appears in the menu bar. For more information, see “Installing Breeze Presenter” on page 12.
About Breeze Presenter

Breeze Presenter lets you create sophisticated, high-impact presentations and e-learning content quickly and easily in three steps: design, edit, and publish.

Designing Breeze Presenter presentations

From within PowerPoint, Breeze Presenter can help you do the following tasks:

- Use an existing PowerPoint presentation as a base for a Breeze Presenter presentation. This can save you the time and effort creating a new presentation. (See “Creating Breeze Presenter presentations” on page 14.)
- Perform accurate PowerPoint conversions, including full support for PowerPoint animations. (See “Using animation, image, and Flash (SWF) files” on page 26.)
- Customize the look and feel of the presentation viewer interface with company logos, colors, and presenter biographies and photos. (See “Working with themes in presentations” on page 69.)

Editing Breeze Presenter presentations

Breeze Presenter can help you change presentations to suit your needs in the following ways:

- You can enhance PowerPoint presentations with multimedia. Add multimedia including audio (such as voice-over narration), quizzes and surveys, or Flash files and Flash video without leaving PowerPoint. (See “Recording audio” on page 34 and “Creating quizzes and questions” on page 43.)
- You can import prerecorded audio into a presentation and match the audio to PowerPoint slide animations. (See “Working with Audio” on page 29.)

Publishing Breeze Presenter presentations

You publish your presentations so that users can view them. Breeze Presenter offers the following features:

- Breeze Presenter is deeply integrated with all Breeze products including Macromedia Breeze Training, Macromedia Breeze Events, and Macromedia Breeze Meeting, as well as Macromedia Captivate, Flash content, and Flash Video (FLV) files. (See “Publishing to a Macromedia Breeze server” on page 86.)
- You can view presentations in the interactive Breeze Presenter viewer. (See “Viewing a presentation in a Breeze meeting” on page 93.)
- You can use Breeze Presenter content with learning management systems (LMS). Breeze Presenter creates SCORM and AICC compliant content. (See “Setting reporting options” on page 61.)

About Breeze Presenter projects and content

There are many ways you can use Breeze Presenter. If you think creatively about new ways to work with Breeze, you can then publish even more engaging content using Breeze Presenter.
Breeze Presenter helps you create rich, on-demand presentations such as the following:

- Sales presentations to drive lead generation or deliver a quote to a prospective client
- Marketing presentations to enrich customer experiences with high-quality, advanced, Flash presentations
- Executive presentations that require rich content such as keynote speeches or annual status speeches
- New product launch presentations
- Financial updates or earnings calls
- General corporate communications

Breeze Presenter offers diverse ways to work with interactive, e-learning content such as the following:

- Product training or tutorials
- Human resources and compliance training
- Self-paced support and customer service training
- Formal assessments
- Professional development

**Breeze Presenter features**

Breeze Presenter includes the following features:

**PowerPoint Integration**  Create presentations in the PowerPoint application with no special training or expensive technical experts.

**Breeze integration**  Use Breeze Presenter presentations in Macromedia Breeze Meetings, Breeze Events, and Breeze Training.

**Publishing to Breeze**  You can publish your presentation to a Breeze server with a few simple steps.

**Advanced audio editing**  With the Audio Editor, you can edit imported and recorded audio from within Breeze Presenter. You don’t need a separate audio-editing application.

**Slide notes integration**  You can create slide notes in PowerPoint and use the notes in Breeze presentations, for example, as a script for recording audio.

**Creating quizzes**  Add sophisticated questions to presentations, and make them interactive to assist in and assess the retention rates of users.

**Creating surveys**  Poll users and obtain information without requiring them to “take a test.”

**Breeze Presentation themes**  You have full control over how your presentations look, including colors and fonts. You can use one of the themes included with Breeze Presenter, or create a custom theme for a distinctive look or to meet a specific objective.

**Importing additional content using attachments**  You can add relevant content, such as documents, spreadsheets, web pages, or images to presentations to give users easy access to additional, related information.
**Importing additional multimedia content**  You can add Flash (SWF) files and Captivate simulations and demonstrations to enhance presentations and reuse existing content.

**Advanced video capabilities**  You can place video files directly into presentations to quickly.

**SCORM and AICC compliant content**  With Breeze Presenter, you can easily make presentations containing e-learning features SCORM and AICC compliant.

**Enhancing presentations with audio narration or music**  Include audio files such as voice-over narration, sound effects, and music into presentations to add the dimension of sound. You can import existing files or record new sound files right in Breeze Presenter.

**Adding search capabilities**  Enable users of your presentations to quickly find information, whether it’s a slide or an attachment.

**Reducing file size**  You can create presentations that are rich, multimedia experiences, but are intelligently compressed to create a small finished file that is easily sharable with anyone using a web browser.

**Adding custom presenter information**  Add a presenter photo and information such as name, title, and a short biography to personalize presentations. A single presentation can have multiple presenters and you can add customized information for all of them.

---

**About Macromedia Breeze**

Breeze is a complete enterprise solution for creating, managing, and delivering your online presentations, web conferencing, and rapid e-learning. Breeze quickly and easily converts existing PowerPoint presentations into valuable assets that employees, customers, partners, investors, and suppliers can access through most web browsers. The Breeze system offers a complete solution for your online multimedia presentation and training needs.

Macromedia Breeze is available as an enterprise solution or as a hosted application service. To learn more about Breeze, please visit the Breeze website at [www.macromedia.com/go/breeze](http://www.macromedia.com/go/breeze).

---

**About creating online presentations**

You create your online presentations in Breeze Presenter first, and then publish the presentations to Breeze. Breeze Presenter can help you quickly and easily create presentations from your desktop PC by making it easy to do the following:

- Add audio narration to the presentation and synchronize animations.
- Convert presentations automatically into online-ready versions.
- Publish your presentation to Breeze.

---

**About managing online presentations**

You can use Breeze to accomplish the following tasks:

- Organize your entire presentation library into a single, sharable repository.
- Control access and permissions to presentation source files and converted Breeze presentations.
About delivering presentations over the Internet

Breeze lets you do the following:

- Deliver presentations over the Internet using Flash Player, so customers, partners, and employees can access Breeze presentations anytime, anywhere.
- Track presentation statistics and content effectiveness by seeing which presentations are viewed most often using reports. You can view reports on quiz and question responses to assess users’ knowledge retention or to gauge overall quiz and survey data.

Macromedia Breeze is available as an enterprise solution or as a hosted application service. For more information, see the Breeze website at www.macromedia.com/go/breeze.

About Breeze Presenter instructional media

Breeze Presenter includes comprehensive online instructions to help you learn the application quickly and become proficient in creating your own presentations:

To open Breeze Presenter Help

1. Open PowerPoint.
2. From the Breeze menu, select Help. (You can also click the Help button in any dialog box.)

- The Quick Start movies provide an animated look at important tasks in Breeze Presenter. You can access the Quick Start movies from the Start page of Breeze Presenter Help.
- The Macromedia Breeze Presenter User Guide introduces you to the Breeze Presenter program and contains much of the same information as Breeze Presenter Help. The Breeze Presenter User Guide is available on the Macromedia Breeze website www.macromedia.com/go/breeze.

Additional resources

For the latest information on Breeze Presenter, plus advice from expert users, advanced topics, examples, tips, and other updates, see the Macromedia Breeze Resource Center at www.macromedia.com/go/breeze_resources, which is updated regularly. Check the website for product tutorials and best practices.

For TechNotes, documentation updates, and links to additional resources in the Breeze Presenter community, see the Macromedia Breeze Support Center at www.macromedia.com/go/support.

System requirements

For a detailed description of system requirements for presentation creators and users who view presentations, see the Breeze website at www.macromedia.com/go/breeze.
Installing Breeze Presenter

After you install Breeze Presenter, you can access all of its features in PowerPoint from the newly added Breeze menu.

To install Macromedia Breeze Presenter on a Windows computer:
1. After you have downloaded the application, double-click the Breeze Presenter EXE file to install the software.
2. Follow the onscreen instructions.
3. A Getting Started presentation (a PowerPoint file) guides you through the steps required to publish your first presentation.
CHAPTER 1
Creating Presentations with Breeze Presenter

After you install Macromedia Breeze Presenter, you can access the application from within Microsoft PowerPoint. You can access all Breeze Presenter authoring functions in PowerPoint by using the Breeze menu.

About the Breeze Presenter workspace

Macromedia designed Breeze Presenter for efficiency and ease of use. Breeze Presenter has the following two components that work together to help authors create and deliver high-quality content for users:

- **Breeze Presenter** enables authors to create content.
- **Breeze Presenter viewer** allows users to view and interact with converted Breeze Presenter presentations.
For content authors, all Breeze Presenter features are accessible from the Breeze menu in PowerPoint.

Planning Breeze Presenter presentations

Creating presentations with Breeze Presenter is fast and easy if you follow these basic steps.

1. Plan your presentation using storyboards, scripts, or whatever organizational materials are appropriate.
2. Open an existing PowerPoint presentation or create a new presentation.
3. In PowerPoint, from the Breeze menu, you can add audio narration, quizzes, presenter information, and other options to your presentation. You can include attachments such as web pages or documents and you can customize themes (the look and feel of the presentation viewer) for each presentation.
4. On your local computer, follow the steps for “Previewing a presentation” on page 14.
5. Publish the presentation to a Breeze server. You can also burn the presentation to a CD or upload the presentation to the web using a third-party FTP software program.

Determining presentation goals

No matter what kind of presentation you want to create, it is helpful to do some planning before you start. Consider first what you want the user to learn, achieve, and so on as a result of viewing your presentation. Defining this goal from the beginning lets you create a comprehensive plan for success. After you have defined the goal of the presentation, you can use an existing PowerPoint presentation and enhance it with the most effective Breeze Presenter options.
When planning, you should consider adding the following elements to your presentation:

**Title slides**  Title slides are usually the first or second slide in a presentation and state the subject of the content.

**Presenter information**  Include the name, title, photo, contact information, and a short biography of the presenter or presenters.

**Custom logos**  Add a company or organization logo to brand and personalize a presentation.

**Copyright information**  Depending on the length of the information, include copyright text on the first or last slide in a presentation, or add a separate slide containing only copyright information.

**Opening and closing slides**  Create a distinctive start and finish to clearly show users the beginning, middle, and end of the presentation. You can use the same opening and closing slide across a series of presentations for a unifying professional look.

**Section divider slides**  Use slides that delineate sections within a presentation. This is especially useful in long presentations.

**Sounds**  Voice-over narration, music, or sound effects can add a new dimension to presentations.

**Quizzing**  Let users interact with the presentation, while you track their learning progress or obtain information (surveys).

**Attachments**  Add existing information as supporting content for presentations. You can include documents, spreadsheets, links to web pages, and images as attachments.

**Breeze Presenter best practices**

Macromedia recommends using these best practices to create a great online presentation:

- Design your online presentation based on the bandwidth capabilities of your audience. If your audience has fast, broadband connections, you can create a graphic-intensive presentation that includes many animations. However, if your audience has slower connection speeds, you should use graphic images that ensure your audience has a good viewing experience.

- It helps to create a written script before recording audio for your presentation. Speaking into a microphone can be more difficult than giving a presentation to a live audience. To ensure a smooth delivery that covers all of your important points, consider creating a script for the entire presentation before recording audio for it. (If you have slide notes written in PowerPoint, you can easily import them into Breeze Presenter to use as a script or as the basis of a script.)

- Add animations enhances the overall presentation. Breeze Presenter supports PowerPoint animations so that you can create powerful, animated, multimedia presentations. Animations add impact to your message and improve the user's overall viewing experience.

- Preview the presentation by publishing it locally before publishing to Breeze. This lets you view the converted presentation to be sure that it meets your requirements.

- Create slide titles to give users easy access to any slide. Check that titles appear in the PowerPoint outline for all slides, including graphic-only slides, before publishing your presentation.
Creating Breeze Presenter presentations

Breeze Presenter presentations are always based on PowerPoint presentations. To create a new presentation, you open an existing PowerPoint presentation (or create a new one) and then add all of the features available in Breeze Presenter. For more information about how to add these features, see the appropriate chapter.

The following procedure describes the general steps for creating a simple Breeze Presenter presentation.

To create a Breeze Presenter presentation:

1. In PowerPoint, open a presentation (PPT) file or create a new one by selecting File menu > New.
2. From the Breeze menu, select the Breeze Presenter features you want to add to your presentation.
   
   You are not required to make any changes before publishing, but adding Breeze Presenter features such as audio narration, SWF files, quizzes, attachments, and a theme will enhance your presentation and give you the opportunity to experiment with the functionality available in Breeze Presenter.
3. Preview the presentation by publishing it locally (to your computer). (For instructions on how to do this, see the next section).
4. If necessary after previewing, return to step 2 and make any changes required.
5. When you are finished, publish the presentation to a Breeze server. For more information, see “Publishing to a Macromedia Breeze server” on page 86.

Previewing a presentation

If you want to check your work, you can preview presentations at any time by publishing to your local computer. This is a fast way to see how the presentation will look to users.

When you preview a presentation, it appears in your default web browser. All of the functionality in the presentation, such as audio and quizzes, works exactly the way it will in the Breeze Presenter viewer. The presentation appears with all of the theme settings and colors you have chosen.

To preview a presentation by publishing to your local computer:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Publish.
3. Select My Computer on the left side.
4. Click Publish. When you publish, the following actions take place:

- By default, a new folder with the same name as the presentation is created and placed in your My Documents\My Breeze Presentations folder. The new folder contains all of the presentation files, and any audio, video, image, and attachment files that are part of the presentation.
- Theme and presenter information are stored in your Local Settings folder (frequently located at C:\Documents and Settings\user name).

5. When the conversion is finished, click View Output.

If you click View Output when the conversion is finished, the presentation appears in your default web browser.
After you have created a presentation, you can use Breeze Presenter to edit your work quite easily. Normally, you will probably create a presentation, preview the presentation locally, edit the presentation to make it just right, and publish the presentation to Breeze.

This chapter contains the following topics:

• “Changing the presentation title” on page 17
• “Adding a presentation summary” on page 17
• “Changing slide properties” on page 18
• “Adding and editing presenters” on page 21
• “Adding attachments to presentations” on page 23
• “Using animation, image, and Flash (SWF) files” on page 26

Changing the presentation title

You can change the presentation title at any time. The title appears in the Breeze Presenter viewer.

To change the presentation title:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Settings tab.
4. In the Title text box, enter a new name for the presentation.
5. Click OK.

Adding a presentation summary

A presentation summary is usually a short description of the presentation contents. Adding a summary is optional and is a useful organizing tool for presentation authors. The summary appears only in the presentation settings of the presentation; it does not appear in the published presentation and is not visible to users.

Note: The presentation summary does appear in Breeze Server after a presentation has been published to Breeze. Presentation authors can search summaries and see the summary when viewing content information.
To add a presentation summary:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Settings tab.
4. In the Summary text box, enter a description of the presentation contents.
5. Click OK.

Changing slide properties

You can easily view and change the properties of any slide in a presentation at any time. This can help you make changes to a slide or group of slides quickly and easily. For example, if you have assigned a presenter to all of the slides, but there are a few slides where another presenter is providing slides or audio narration, you can use slide properties to assign the new presenter to the correct slides.

The following sections describe the slide properties you can change:

• Setting a navigation name
• Setting slide advance behavior
• Setting the presenter for a slide
• Setting a Go to Slide option
• Adding video to a slide

Note: You can select multiple slides to easily update the Presenter and Advance by User settings. Simply select a slide, hold down Shift or Control, and select additional slides. (The Navigation name, Go to Slide, or Video properties cannot be changed this way.)

Using slide properties, you can change options for individual slides or a group of slides.
Viewing slide properties for all slides in a presentation

You can view a short description of all slides in a presentation in one central location. For example, you can see what presenters are associated with each slide, if navigation names have been assigned, and if any slides must be advanced by the user.

To view slide properties for all slides:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
   The Slide Properties dialog box appears.
3. Use the scroll bar on the right side to view all of the slides in the presentation.

Setting a navigation name

You can set a navigation name for a slide that is different than the slide title. A clear and descriptive navigation name can make it easier for users to navigate through the published presentation. The navigation name appears in the sidebar (Outline and Thumb panes) in the published presentation.

For more information about the sidebar and panes, see Chapter 5, “Designing the Presentation Experience,” on page 69.

A navigation name can be useful if your slide titles are long or if you want to display a more descriptive name than the slide title in the final presentation for users. For example, the first slide in the presentation might have the generic slide title “Introduction,” but you can assign a navigation name such as “About Product X.”

To set a navigation name:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. In the Navigation Name text box, enter the text you want to use.
5. Click OK twice.

Setting a Go to Slide option

Presentations usually play linearly (slide 1, slide 2, and all the way through until the end). However, you can change the order by using the Go to Slide option. This enables you to skip slides in the presentation, without having to remove them. For example, if you set Go to Slide 8 after slide 5, your presentation will play until slide 5 and then jump to slide 8.

The Go to Slide option can be useful if you are creating one presentation that several audiences must use. For example, you can create a presentation about benefits options for full-time and part-time employees. When part-time employees view the presentation, they can skip slides containing information for full-time employees. The Go to Slide option works the same whether the presentation is used within Macromedia Breeze or viewed locally in a web browser.
To set Go to Slide options:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select the slide that will be the starting point and click Edit.
4. In the Go to Slide pop-up menu, select the slide to which you want the presentation to jump.
5. Click OK twice to close all dialog boxes.

Adding video to a slide

You can include video files in a presentation, which appear in the viewer sidebar. This can be especially useful if you have a video of a speaker, sometimes called a “talking head” video. Breeze Presenter supports the Flash (SWF) and Flash Video (FLV) file formats. When video is added to a presentation, it appears in the location used for presenter photographs.

Note: Video is added individually to each slide. If you have one “talking head” video file that you need to use for multiple slides, split the video into separate files.

Video files added to presentations appear in the viewer where the presenter photograph is located.

To add video to a slide:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. Next to the Video text box, click Browse.
5. Navigate to a SWF or FLV file, select the file, and click Open.

   **Note:** If you select an FLV file and you publish the presentation to Breeze, the FLV file will also be hosted by Breeze. When a user views the presentation, the FLV file automatically streams. If you select a SWF file and publish the presentation to Breeze, the SWF file is delivered as part of the presentation.

6. Click OK twice to close all dialog boxes.
7. To test the file, preview the presentation. (For more information, see “Previewing a presentation” on page 14).

**Setting slide advance behavior**

By default, slides in a presentation advance automatically. You can, however, set individual slides to advance only when users click the Next button. This is useful if, for example, for a slide containing an interactive Captivate simulation that has no set duration time for the slide to play.

To set a slide so that users advance it:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. Select Advance by User.
5. Click OK twice.

**Adding and editing presenters**

A presenter is the person who is providing the information in a presentation. For example, if the subject is software training, the likely presenter is an instructor, trainer, or product manager. A single presenter can be assigned to all slides in a presentation or different presenters can be assigned to individual slides.

You can provide users with valuable information about the presenter including the name, job title, a short biography, a logo, and contact information such as an e-mail address or phone number. This can make a presentation more credible, personal, and interesting. It also gives users the ability to ask follow-up or clarification questions.

**Adding a new presenter profile**

In Breeze Presenter, you add presenter profiles to one central location. These profiles are stored and can be used in any presentations you create.

To add a new presenter profile:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Click Add.
5. Enter the name of the new presenter.

   Note: The Name text box is the only text box that you must fill in to create a new presenter.

6. (Optional) Enter a job title, such as Vice President.

7. (Optional) Next to the Photo text box, click Browse and navigate to an image file in JPEG or PNG format. After selecting an image file, the image appears in the Presenter Photo area on the right. (This is the exact size the image will appear in the presentation when it’s seen in the Breeze Presenter viewer.)

   Note: The recommended size for a presenter photo is 88 x 118 pixels.

8. (Optional) Next to the Logo text box, click Browse and navigate to a logo file in JPEG or PNG format. After selecting an image file, the image appears in the Logo preview on the right. (This is the exact size the logo will appear in the presentation when it’s displayed in the Breeze Presenter viewer.)

   Note: The recommended size for a logo is 148 x 52 pixels.

9. (Optional) Enter an e-mail address, such as jdoe@companyzyxwv.com.

10. (Optional) In the Biography text box, enter a short biography of the presenter, such as professional and educational credentials, length of time with company, a phone number, or job duties.

11. If you want to make this presenter the default presenter for all presentations, select the Default option.

12. Click OK.

13. Click Close.

Setting the presenter for a slide

You can set one presenter for an entire presentation or set different presenters for individual slides within a presentation.

To set the presenter for an entire presentation:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Click the first slide in the list.
4. Hold down Shift and click the last slide in the list. (Use the scroll bar on the right, if necessary, to navigate to the last slide in the list.)
5. Click Edit.
6. In the Presenter pop-up menu, select a name from the list.
7. Click OK.

   The presenter is now associated with all slides in the presentation.
8. Click OK to apply your changes and close the Slide Properties dialog box.
To set the presenter for an individual slide:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. In the Presenter pop-up menu, select a name from the list.
5. Click OK.
   The presenter is now associated with the slide.
6. Click OK to apply your changes and close the Slide Properties dialog box.

Editing an existing presenter
After you have added a presenter, you can change presenter information, such as the job title, e-mail address, or biography, at any time.

To edit an existing presenter:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Select a presenter from the list and click Edit.
5. Change properties such as the job title, e-mail address, or biography.
6. Click OK to close the Presenter dialog box.
7. Click Close to close the Breeze Presenter Preferences dialog box.

Deleting a presenter
You can delete a presenter and all corresponding information, such as the biography and e-mail address, at any time.

To delete a presenter:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Select a presenter from the list and click Delete.
5. Click Close to close the Breeze Presenter Preferences dialog box.

Adding attachments to presentations
Attachments are files or URL links that you add to your presentation to provide users with supplemental information. Using attachments is a great way to take existing content, such as web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or spreadsheets, and incorporate it into your presentation. You can also add links to websites or documents hosted by the Breeze Server or another third-party system.
Attachments are accessible to users when they view your presentation. An Attachments button appears on the bottom of the Breeze Presenter viewer. When the user clicks the Attachments button, a list of all of the attachments associated with the presentation is displayed. Users can click the individual attachment to open the file.

This example shows the Attachments window with several different types of attachments listed.

The following table lists common attachment types and what happens when a user clicks the file.

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Opens in</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashPaper</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>Microsoft Word document</td>
<td>Microsoft Word, if installed</td>
</tr>
<tr>
<td>Microsoft Excel spreadsheet</td>
<td>Microsoft Excel, if installed</td>
</tr>
<tr>
<td>Microsoft PowerPoint presentation</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>Text (TXT) file</td>
<td>Default text editor such as Notepad or Wordpad</td>
</tr>
<tr>
<td>PDF file</td>
<td>Adobe Acrobat Reader, if installed</td>
</tr>
<tr>
<td>Flash (SWF) file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>Image or graphic file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>URL link</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
</tbody>
</table>
To add an attachment to a presentation:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Click Add.
5. Enter a unique name for the attachment that will distinguish it from any other attachments you add.
6. In the Type pop-up menu, select File or Link.
7. If you selected Link in the Type pop-up menu, enter the full path of the link in the URL text box. If you selected File in the Type pop-up menu, click the Browse button to navigate to the file.
8. Click OK.
9. Continue adding attachments as needed and when you are finished, click OK.

Editing attachment information
After adding an attachment to a presentation, you can edit information about the attachment, such as the name and location, at any time.

Note: If you need to edit the attachment contents, open the file in the application in which it was created. For example, if the attachment is a spreadsheet created in Excel and you must change numbers in the spreadsheet, open the file in Excel and edit the numbers. After editing, add the attachment again in Breeze Presenter to incorporate the changes.

To edit a presentation attachment:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Select an attachment and click Edit.
5. Make any necessary changes to the name or location and click OK.
6. Click Close.

Deleting attachments
You can delete presentation attachments at any time.

To delete a presentation attachment:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Select an attachment and click Delete.
5. Click OK.
Using animation, image, and Flash (SWF) files

You can incorporate animations and Flash (SWF) files into your Breeze Presenter presentations. If you already have PowerPoint animations, such as flying or dissolving text, Breeze Presenter will convert those animations seamlessly and they will appear in your final presentation exactly as they appear in PowerPoint.

If you have SWF files containing animation, you can add those files to presentations. Simulations and demonstrations created with Macromedia Captivate are also in SWF file format and you can incorporate them into presentations easily.

*Note:* For additional information about adding video, see “Adding video to a slide” on page 20.

Synchronizing audio and animation timing

After previewing your presentation, you might want to edit the timing of PowerPoint animations to better synchronize with added audio files. For example, if you have a slide with bulleted text items that appear one by one, you can adjust the timing so that the audio track matches the action of the text.

To edit animation timings:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Synchronize Audio.
3. In the Synchronize Audio dialog box, click Previous or Next, if necessary, to navigate to the slide containing the audio and animation timing you want to edit.
4. Select Change Timings (the stopwatch icon) to play the audio.
5. As the audio plays, click Next Animation to set the timing for the first animation in coordination with the audio. Select Next Animation again to set the timing for the next animation. Repeat this step for all animations on the slide.
6. When you are finished, click Stop Editing.
7. Click OK.

*Note:* The Synchronize Audio dialog box only synchronizes PowerPoint "On mouse click" animations. In contrast, timed animations use the timing set in the Custom Animation dialog box in PowerPoint.

Adding pauses after animations play

If your presentation includes PowerPoint animations, you can have the presentation automatically pause after the animations play. This is useful if you want to clearly define where the animation ends and the presentation begins again.

To have the presentation pause after an animation plays:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Click the Settings tab.
4. Select Pause After Each Animation.
5. Click OK.

When this option is selected, users must click the Play button in the toolbar to start the presentation again after a pause.

**Inserting Flash (SWF) files**

A Flash (SWF) file is a compiled, viewable-only Flash file that delivers graphics and animation over the Internet. You can insert SWF files directly into your presentations. You can use a SWF file for emphasis, such as an animated pointer, or to add more content to a presentation.

The following are tips for adding SWF files to presentations:

- Only SWF files published at 30 frames per second play properly.
- The SWF file you want to embed must not attempt to make any changes outside its own file. Therefore, the code cannot refer to the following variables: `_level#`, `_global`, or `stage`.

**To insert a SWF file into a presentation:**

1. In PowerPoint, open a presentation (PPT file).
2. Navigate to the slide to which you want to add the SWF file.
3. From the Breeze menu, select Insert Flash.
4. Navigate to the location of your SWF file. Select the SWF file and click Open.

Breeze Presenter adds the SWF file to the slide.
5. (Optional) If necessary, select the file and drag it to a new location on the slide.

**Tip:** You can preview what the SWF file will look like by viewing the presentation in PowerPoint Slide Show mode. In PowerPoint, from the View menu, select Slide Show.

**Inserting Captivate files**

Macromedia Captivate is a software application that lets you create animated simulations and demonstrations. If you have Captivate projects, you can add them to your Breeze Presenter presentations.

Certain types of Captivate projects, such as training demonstrations or software simulations, can be particularly useful in presentations.

**To insert a Captivate demonstration or simulation into a presentation:**

1. In PowerPoint, open a presentation (PPT file).
2. Navigate to the slide to which you want to add the Captivate demonstration or simulation.
3. From the Breeze menu, select Insert Flash.
4. Navigate to the location of your Captivate simulation or demonstration SWF file. Select the SWF file and click Open.

Breeze Presenter adds the Captivate demonstration or simulation SWF file to the slide.
5. (Optional) If necessary, select the file and drag it to a new location on the slide.
Controlling inserted SWF files

When you add a SWF file to a Breeze Presenter presentation, you can choose whether the added SWF file is controlled by the Breeze Presenter playbar or by a playbar in the original SWF file. For example, if you add a Macromedia Captivate demonstration SWF file to the presentation, the demonstration can be controlled by the Breeze Presenter playbar in the viewer or by the playbar that is in the Captivate demonstration.

To set how an inserted SWF file is controlled:
1. In PowerPoint, open a presentation (PPT file) containing an added SWF file.
2. From the Breeze menu, select Presentation Settings.
3. Click the Flash Files tab.
4. Select one of the Flash files in the list.
5. Do one of the following:
   - Select the Controlled by Presentation Playbar option. The selected Flash file will be controlled by the Breeze Presenter playbar when the published presentation is seen by users in the viewer.
   - Deselect the Controlled by Presentation Playbar option. The selected Flash file will play within the viewer, but cannot be controlled by the viewer playbar.
6. Click OK.

Setting image quality for a presentation

Setting image quality is a challenge of balancing quality and file size. If you set images to a higher quality, the presentation file size can become large. Setting images to a lower quality results in a smaller file size. You should test different settings to find the best compromise.

To set image quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. Select an image-quality option:
   - **High** results in the largest file size and highest quality image.
   - **Medium** is the best balance between file size and image quality.
   - **Low** results in the smallest file size and lowest quality image.
5. (Optional) Select the Require Slides to Download Completely Before Playback option to require that all slides download before the presentation begins playing. This option is recommended if you think users might view your presentation on computers with slow connections speeds. If this option is enabled, it will take longer for the presentation to start, but the slides will play smoothly after the presentation begins.
6. Click Close.

*Note:* The Medium and Low options are useful in situations with extreme bandwidth limitations.
CHAPTER 3
Working with Audio

Macromedia Breeze Presenter lets you add narration, music, step-by-step instructions, or almost any sound to your projects. You can use audio to provide instructions or to emphasize key points in the presentation. In general, sound can be as individual and flexible as any other presentation component.

You can use audio in Breeze Presenter presentations in a variety of ways. For example, Breeze Presenter can help you with the following tasks:

• Adding sound to an individual slide
• Adding special sounds to quizzes for correct and incorrect answers

Breeze Presenter lets you record your own audio files (using some simple equipment) or import existing files. Imported files can be in WAV or MP3 format. (If you add a WAV file to a presentation, Breeze Presenter automatically converts the WAV file to MP3 format in the generated presentation.)

After you add audio to a presentation, you can synchronize the timing with other content, such as animations. For example, if your presentation contains PowerPoint animations such as text that “flies in,” you can synchronize the animations with the audio. (For more information, see “Using animation, image, and Flash (SWF) files” on page 26.) Breeze Presenter also contains features that enable you to add silent periods to audio files and to normalize audio for all slides so that the sound level is consistent.
Adding audio files to your presentation

You can quickly add WAV or MP3 format audio files to a presentation. Simply import the files and use them as opening music, narration, instructions, or for any other purposes.

Note: Breeze Presenter automatically converts imported WAV files to MP3 files.

To add audio to a slide:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Import Audio.
3. Select the slide to which you want to add the audio file.
4. Click Browse and navigate to the audio file (WAV or MP3) you want to add to the slide.
5. Select the audio file and click Open.

Breeze Presenter adds the audio file to the selected slide. The name of the audio file appears in the File column and the length of the audio file appears in the Time column.

Note: You can add as many audio files as you want, but they cannot exceed more than 90 minutes of audio per slide in a presentation.

About audio recording equipment

Having the right audio equipment makes a big difference in the quality of recorded audio. Surprisingly, basic audio equipment can be relatively inexpensive; your equipment should include some if not all of the following:

Computer with a sound card  The sound card installed in your computer acts as a digital recorder for audio.

Microphone  If possible, you should avoid using the USB microphone packaged with your computer. Use a proper professional quality microphone cable and a stand to hold the microphone while you are recording.

Microphone preamplifier  A preamplifier boosts the signal of the microphone. The microphone input of your computer's sound card probably includes a preamplifier, but it's most likely a poor quality one. When purchasing a preamplifier, you can choose a small mixer or a stand-alone version. Mixers let you connect several microphones and devices to one location, and you can adjust their volumes independently. Stand-alone preamplifiers can be better than mixers at filtering out unwanted noises.

Speakers  The speakers that came with your computer are probably good enough for listening to any audio you record. However, if you are working on a laptop, you must use standard desktop computer speakers instead of the built-in laptop speakers.

In Microsoft Windows operating systems, you can usually find speaker (sound) settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.

Headphones  Headphones are important because when the microphone is on, speakers can cause distracting feedback. Additionally, it's best to use closed-ear headphones that prevent sound from leaking, which the microphone can pick up.
Recording software  A wide range of recording software is available. Important software features include editing capabilities (to fix mistakes), music and sound-effect options, and the capability to create the file format you require (such as MP3 or WAV). An excellent, easy-to-use, and free application is called Audacity (available from http://audacity.sourceforge.net).

Recording area  After you have acquired the necessary audio equipment, the most important action you can take before recording is an obvious one: Find a quiet place to record. Try closing doors, turning off any unnecessary computer equipment, turning off or lowering lights that might be making noise, turning off phone ringers, beepers, and pagers. Also, it helps to tell coworkers that recording is in progress.

About recording audio

You can follow these tips to ensure that you are recording the highest quality audio possible.

• “Setting up audio equipment” on page 31
• “Setting sound card options” on page 31
• “Changing audio recording settings” on page 31
• “Placing the microphone” on page 32
• “Improving microphone techniques” on page 32
• “Editing sound” on page 32
• “Reviewing the presentation” on page 32

Setting up audio equipment

When you have acquired the necessary audio recording equipment, you must set it up properly. First, plug the microphone into the mixer or stand-alone preamplifier, and then plug the output of that device into your computer sound card’s “line in.” Plug the headphones into your computer. Then, set the volume on the mixer or preamplifier. Begin speaking to test the volume levels, and carefully raise the volume until it shows just under zero.

Setting sound card options

You can open the software application that controls the sound card. (In most Windows operating systems, you can find sound settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.) When you select the recording source (line in), you can adjust the volume to 100%. If you are using a mixer or stand-alone preamplifier, the actual recording level can be controlled from there.

Changing audio recording settings

After starting your audio recording software, you can change the settings as necessary. Mixers and preamplifiers don’t have sound-level controls, so you rely on the meters when recording. While recording, you should ensure that you don’t exceed zero on the meters, or the sound will be distorted.
Placing the microphone

Positioning your microphone correctly can make a big difference in the finished audio file. First, get as close as possible to the microphone (within 4 to 6 inches) so that you avoid recording any other nearby sounds. Don't speak down to the microphone; instead, position it above your nose and pointed down at your mouth. Finally, you should position the microphone slightly to the side of your mouth, because this can help soften the sound of the letters s and p.

Improving microphone techniques

You should always have a glass of water nearby so you can avoid “dry mouth.” Before recording, turn away from the microphone, take a deep breath, exhale, take another deep breath, open your mouth, turn back toward the microphone, and start speaking. This can eliminate breathing and lip-smacking sounds frequently recorded at the beginning of audio tracks. Speak slowly and carefully. You may feel that you are speaking artificially slowly, but you can adjust the speed later by using your audio recording software. Finally, keep in mind that you don’t have to get everything right the first time. You can listen and evaluate each recording and re-record if necessary.

Editing sound

Editing sound is similar to editing text. You should listen carefully to your recording, delete any extraneous sounds, and then use the options available in your software to polish the sound. You can add any music or sound effects you require, but make sure to save your audio track in the correct format (MP3 or WAV files).

Reviewing the presentation

After you have added the audio to the presentation, listen to it again. You should view the presentation as users normally would. Finally, it helps to ask others to preview the presentation file. If necessary, you can edit the audio again, on a per-slides basis.

Setting audio recording quality

Audio files present the common challenge of balancing quality against size. The higher the sound quality, the larger the file size. The more you compress a sound and the lower the sampling rate, the smaller the file size and the lower the quality. Breeze Presenter lets you control the way sound is recorded and compressed based upon your input and output requirements.

Creating audio in Breeze Presenter is essentially a two-part process: you record audio in WAV format and then Breeze Presenter converts the WAV file into an MP3 file.

Of course, when working with audio, you must keep your users’ connection speed in mind. If a user is likely to access the Breeze Presenter presentation by using a dial-up modem, use a higher compression and lower sampling rate, such as 56 Kbps. However, if you are distributing the presentation on a CD-ROM, you can use a lower compression and higher sampling rate, such as 144 Kbps. In the best development case, you should experiment to find the optimal balance between sound quality and file size for your users.
To set audio recording quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. In the Audio Options dialog box, set the following options:
   - **Input Source** specifies the type of recording device you are using to create audio. Select Microphone if you are using a microphone, or select Line in if you are using a different type of recording device.
   - **Audio Quality** specifies a quality level for the audio. Select an option in the pop-up menu. Remember that a higher quality level results in a larger audio file size.
   - **Calibrate Input** displays the Calibrate Microphone dialog box. It’s important to calibrate your recording device for optimal sound quality.
5. When you finish recording, click OK.

Changing the audio input source
If you are recording audio for a presentation, you can either use a microphone or the line-in option that is usually included with an external audio device such as a tape deck or stereo amplifier.

To change the audio input source:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Audio Source tab.
4. In the Audio Input Source area, select either Microphone or Line in.
5. (Optional) Select the Always Prompt to Set Microphone Level Before Recording option if you want to calibrate the microphone before each recording session. This is useful if you use different microphones or if you record in different environments (i.e., a quiet room versus an area with background noise).
6. Click Close.

Calibrating microphones for recording
If you are recording audio for a presentation, you must set the microphone or recording device to the correct recording level. This process is called **calibrating the recording device**. Breeze Presenter can detect optimal microphone and recording sensitivity levels automatically.

**Note:** Breeze Presenter must be able to detect a recording device before trying to calibrate. Check that a microphone or recording device (such as a tape deck or stereo amplifier) that uses the line-in option is connected to your computer properly and is turned on before calibrating.
To calibrate a microphone or recording device:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio.
   The Set Microphone Recording Level dialog box appears.
3. To set the correct recording device level, speak the following sentence into the microphone until the red recording window becomes green:
   “I am setting my microphone recording level for use with Breeze Presenter.”
4. When you finish, click OK.

Recording audio
If you have a microphone connected to your computer, you can record audio that you want to include for a slide. You can use audio for many types of narration or instruction.

To record audio:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio.
3. Calibrate your microphone by following the instructions in the Set Microphone Recording Level dialog box.
4. Click OK.
5. Click Record Audio to begin recording.
6. Speak into the microphone or recording device.
7. When you finish, click Stop.
   Breeze Presenter converts the audio to MP3 format.
8. Click Play to listen to the recording.
9. (Optional) Click Previous or Next to record audio for another slide.
10. When you finish, click OK.

Importing slide notes
If you have created slide notes in PowerPoint, you can import the notes into the script window in the Record Audio dialog box or the Synchronize Audio dialog box. This is useful if you want to use the slide notes as a script when recording an audio file as voice-over narration.

To import slide notes into a presentation:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio or Synchronize Audio.
3. If necessary, select the View script option.
4. Click Import Notes.
5. Select the slide notes to import:

- **Current Slide** imports notes from the slide that is currently displayed.
- **All Slides** imports notes from all slides in the presentation.
- **Slides** lets you to select specific individual slides in the presentation. To select multiple slides, hold down Shift or Control and select the slide numbers in the list.

6. Select the import options:

- **Append Imported Notes to Current Scripts** adds any imported notes to the end of existing scripts.
- **Replace Current Scripts with Imported Notes** removes any existing scripts before importing the notes selected on this dialog box.

7. Click OK.

**Exporting scripts into PowerPoint**

If you have created or modified a script in Breeze Presenter in the Record Audio dialog box or the Synchronize Audio dialog box to use while working with audio, you can export the script into PowerPoint. In PowerPoint, the script is imported and becomes slide notes.

To export scripts into PowerPoint:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio or Synchronize Audio.
3. If necessary, select the View script option.
4. Click Export Script.

   The Export Scripts dialog box appears.
5. Select the scripts to export. You can choose the current script, all scripts, or scripts on specific slides.
6. Select an export option. You can append scripts to existing PowerPoint notes (this adds script text to the end of any existing PowerPoint slide notes text) or replace existing PowerPoint notes with scripts (this deletes any existing PowerPoint slide notes text before adding the script text).
7. Click OK.

**Adding silence to an audio file**

You can add a period of silence to any audio file that is part of a Breeze Presenter presentation. This feature is particularly useful in the following situations:

- If you import an audio file and need to synchronize the audio with slides
- If you need to make an existing audio file work in a presentation without having to edit the audio extensively
- If you have inserted a Flash file with audio, such as a “talking head” video of a speaker, into a presentation and want to synchronize the Flash file audio with slides
To add a silence period to an audio file:
1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
   The Audio Editor dialog box appears.
3. You can add silence anywhere in a presentation, including a specific location within an audio file. Click the location in the presentation, or the exact location within an audio file, on the waveform to which you want to add the silent period.
4. From the Insert menu, select Silence.
   The Insert Silence dialog box appears.
5. In the Insert text box, enter a number to specify the length of silence (in seconds).
6. In the pop-up menu to the right, select the position in the audio file to which you want to add the silence:
   - **Cursor Position (default)** This option adds silence at the point in the waveform you selected in step 3.
   - **Start of Slide** This option adds the silent period to the beginning of the slide containing the location selected in step 3.
   - **End of Slide** This option adds the silent period to the end of the slide containing the location selected in step 3.
7. Click OK.
   Breeze Presenter adds the silent period to the audio file and displays it in waveform.
8. To test the audio file with the silence added, click Play in the lower-left corner of the Audio Editor dialog box.

Adjusting audio volume

You can adjust the volume of audio files included in your presentations. After adjusting the volume, preview the presentation to see if the sound level is acceptable.

To adjust the volume of audio files:
1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
3. From the Tools menu, select Volume.
   The Adjust Volume dialog box appears.
4. Click the volume slider on the left side and drag it up to increase volume, or down to decrease volume.
5. You can change the audio processing options, as follows:
   - **Normalize** allows Breeze Presenter to adjust the sound volume automatically. Normalizing audio helps keep the sound level consistent between slides.
   - **Dynamics** amplifies quiet sections of the audio to help compensate for variations in audio volume.
6. (Optional) Click Advanced Controls.

**Ratio** specifies the maximum amplification that Breeze Presenter will use. The default setting of 2.0 sets the quietest sections of the audio to be amplified by a factor of 2. A higher setting can improve a project that has large disparities between quiet and loud sections, but can also amplify background noise.

**Noise Threshold** controls the amplification of background noise. Breeze Presenter doesn’t amplify any sound below the threshold. If background noise is amplified too much, it may help to set a higher noise threshold. (Note that the Dynamics option does not work well with high noise levels.)

7. When you finish, click OK twice to close all the dialog boxes.

**Editing audio files**

You can edit the audio in your presentation at any time. Using Audio Editor, you can listen to an audio file, insert silence, adjust volume, and change a number of other options.

Use the Audio Editor to edit audio files you record for a presentation or import into a presentation.

**To edit an audio file:**

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
3. Use the buttons and menu options to make any necessary edits. You can cut and paste sections of the audio file, insert periods of silence to lengthen the audio file, adjust volume, import a different audio file, and more.

**Cut** lets you cut the selected portion of the audio file.
**Copy** lets you copy the selected portion of the audio file.
**Paste** lets you paste information from the Clipboard. (For example, if you select a section of the audio file, and then click Cut or Copy, Breeze Presenter places the selected audio on the Clipboard. You can then click Paste to place the audio back into any location within the audio file.)

**Delete** removes the selected portion of the audio file.

**Undo** lets you undo the previous action.

**Redo** lets you redo the previous action.

**Zoom In** enlarges the waveform.

**Zoom Out** shrinks the waveform.

**Record/Insert New Audio** begins recording audio. (You will need a microphone.)

**Play** starts the audio file.

**Pause** temporarily stops the slide from playing. (Click Play to resume playing the audio file.)

**Stop** ends playback of the audio file.

**Slide Number** specifies the slide selected in the waveform. For example, slide 4 or 12.

**Playhead** specifies the selected location, in seconds, within an individual slide on the waveform. For example, if you are working with a slide that is 5 seconds long and you click in the middle of the slide on the waveform, this playhead area displays approximately 00:00:02.500.

**Selected** specifies the total playing time of the presentation, if no span of time is selected on the waveform. If you have selected a span of time on the waveform, this area displays the amount of time selected.

**Scale** specifies the scale at which the waveform is displayed. (To change the scale, click Zoom In or Zoom Out.)

4. When you finish editing the audio file, click OK.

**Using the Audio Editor**

Breeze Presenter lets you edit the timing of audio files after you record or import them. Having control over the timing of audio files gives you the ability to use audio files of different lengths and incorporate them smoothly into presentations.

After you record or import an audio file, the file appears as a waveform in the Audio Editor dialog box. If your presentation contains multiple audio files, you can see which audio files are assigned to specific slides.

**To edit audio timing:**

1. In PowerPoint, open a presentation (PPT file) containing audio files.

2. From the Breeze menu, select Audio Editor.

In the Audio Editor dialog box, Breeze Presenter displays any audio files incorporated into the presentation as waveforms. Slide numbers are shown along the top of the waveform so you can see exactly how the audio files are currently distributed across the slides. Breeze Presenter lets you import or create an audio file and then distribute that audio file across multiple slides.
To change how audio files are distributed across slides:
• In the Audio Editor, click a slide divider at the top of a red slide marker line and slide the divider to the left or right.
  The waveform remains static, but you can change where the audio file begins to play within the presentation. This option is particularly useful if you have a long audio file and need to experiment with assigning the file to one slide or having it play over multiple slides.

To listen to an audio file:
• In the Audio Editor, click a location within the waveform and then click Play in the lower-left corner of the Audio Editor dialog box or press the spacebar on your keyboard.
  The audio plays from the location you selected to the end of all audio in the presentation. (You can stop the playback at any time by clicking Stop in the lower-left corner of the Audio Editor dialog box or pressing the spacebar on your keyboard.)

To zoom in on a particular area of the waveform:
• In the Audio Editor, click the waveform and then click the Zoom In or Zoom Out icon in the toolbar. (Alternatively, click in the waveform and roll your mouse wheel to zoom in and out).
  The scale at which you are viewing the waveform is shown in the Scale information box in the lower-right corner of the dialog box.

After you have added audio files to your presentation, you can use the Audio Editor to cut or copy entire audio files or portions of audio files and paste them in a new location.

To cut or copy and paste audio:
• In the Audio Editor, select a section of an audio file directly on the waveform, click Cut or Copy, click a different location on the waveform, and click Paste.

To delete an entire audio file or portion of an audio file:
• In the Audio Editor, select a section of an audio file directly on the waveform and click Delete.

To import an audio file into a presentation:
• In the Audio Editor, click a location within the waveform, select Insert Recording (lower-left corner), navigate to a file, and click Open.
  The audio file is imported directly into the presentation in the location you specified.

Setting audio quality for a presentation

You can set the audio quality level for a presentation. Generally, you want to set the quality as high as possible within an acceptable file-size limitation. Because a higher quality results in a larger file size, you should experiment to achieve the correct balance between quality and file size. (The default setting is Medium.)

To set audio quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. Under Audio quality, select one of the following options:
   - **High** results in the largest file size and highest quality audio.
   - **Medium** is the best balance between file size and audio quality.
   - **Low** results in the smallest file size and lowest audio quality.
   **Publish Without Audio** removes audio files from the presentation before publishing.
5. Click Close.

**Previewing audio**

After you add an audio file to the presentation, you can preview the audio to test it. A quick way to listen to the audio is by viewing the slide show directly from within the Audio Editor.

**To preview audio:**
1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor
3. From the View menu, select Slide Show.
4. When you finish, click Close.
You can use Macromedia Breeze Presenter to create interactive e-learning presentations that are SCORM or AICC compliant for use with a learning management system. Breeze Presenter lets you do the following tasks:

- Add a variety of question types in presentations including multiple-choice, true or false, matching, rating scale (likert), fill-in-the-blank, and short answer.
- Create quiz questions that are graded or are survey questions (not graded).
- Use branching to customize content in response to user answers. Branching provides different paths for correct and incorrect answers. You can set branching at the quiz or question level.
- Provide instant feedback to users through separate messages for correct, incorrect, and incomplete answers.
- Create quizzes that automatically integrate with Macromedia Breeze. Capture scoring data to track user progress and generate reports to view information about how users are using presentations.
About creating quizzes and questions

When you create e-learning content for presentations, you can create a combination of quizzes and questions.

Quizzes are the “containers” that hold questions. You can use the Quiz Manager to create a single quiz for a presentation or multiple quizzes in a single presentation. Then you add questions to the quiz or quizzes. You can add graded questions, survey questions, or a combination of both to each quiz. Quizzes are assigned an Objective ID, a number that specifies an objective set in your learning management system or Breeze. Using quizzes and their default Objective IDs is the best way to coordinate Breeze Presenter presentations with Breeze and content that already exists.

The Quiz Manager lets you organize all of the quizzes and questions in a presentation.

When you create a question, a new slide is added to your presentation, which users will see when they view it. The new slide’s design is based on the master slide template (a PowerPoint feature) so the question slide will look like the other slides in your presentation. You can customize the new question in many ways such as jumping to a particular slide in the presentation, adding custom audio feedback, or opening an attachment based on a correct or an incorrect answer.
About branching in Breeze Presenter presentations

Before adding e-learning content to presentations, consider using branching in your quizzes, questions, and surveys. Branching is an important concept in creating effective e-learning materials and is an excellent way to customize presentations. Branching (sometimes called “contingency branching”) means that the path a user takes through the program is determined by responses made to questions. For instance, you can create branches in response to correct answers, incorrect answers, an option selected by the user, or based on the user’s experience, job category, level, or any other category. You have many options for answer paths including continuing the presentation, going to a specific slide, or opening a URL.

Creating quizzes and questions

You can design many different types of questions such as multiple-choice, short answer, matching, true or false, rating scale (Likert), and fill-in-the-blank. Questions can either be graded or be surveys that gather information.

By setting up branching, you determine what happens when users answer questions correctly or incorrectly. For example, you can set one action (such as “Go to the next slide”) when a user gives a correct answer, and you can set a different action (such as “Open URL”) when a user gives an incorrect answer.

Reporting lets you track student performance with any type of quiz. Track the number of attempts, log correct and incorrect responses, and send pass/fail data to Breeze. You can also choose to provide students with specific feedback based upon correct or incorrect responses.

You can create six different types of question or survey slides in Breeze Presenter:

• Multiple-choice
• True or false
• Fill-in-the-blank
• Short answer
• Matching
• Rating scale (Likert)

Quizzing tricks and tips

The quizzing functionality in Breeze Presenter is flexible and gives you many design options for creating presentations that include e-learning content. For example, quizzes can be simple and straightforward or more sophisticated with detailed branching. Here are a few tricks and tips to try when adding quizzes to your presentation.

• When creating a matching question, you can drag items between the two columns to create correct matches.
• Try customizing feedback messages to accurately communicate with presentation users.
• There are many options for responding to user answers. Experiment with branching to customize presentations for different types of users.
• Consider adding custom audio feedback based on how users answer questions. You can select different audio for a correct answer and an incorrect answer.

• Try editing the settings in the Show Score at End of Quiz option. You can write custom pass and fail messages, design the slide using background colors, and choose how to display the score.

Creating a quiz

The first step to add e-learning options to a presentation is to create a quiz. When you open the Quiz Manager for the first time, a default quiz is displayed. You can use the default quiz or add more quizzes as necessary. Follow the steps below to add an additional quiz.

To create a new quiz:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. In the Quiz Manager, click Add New Quiz.
4. In the New Quiz dialog box that appears, accept the default name or enter a new name in the Name text box.
5. From the pop-up menu next to Required, select an option. When selecting an option, consider how the quiz fits in with your e-learning strategy for the presentation. For example, you can require users to pass the quiz or allow them to skip the quiz.
6. Select the settings you want to incorporate into the quiz, such as allowing backward movement, allowing users to review the quiz, and showing a score at the end of the quiz.
7. Select the Show Questions in Outline option only if you want the question slide name to appear in the outline when users see the presentation in the Breeze Presenter viewer. If you do not select this option, a single entry with the quiz name appears in the outline. This option is off by default. For more information, see “Using the presentation Outline pane” on page 92.
8. Click the Pass or Fail Options tab.
9. Select an option in the Pass/Fail scoring area. Choose from a percentage of total score to pass (e.g., 80%) or a specific number in the total score to pass (e.g., 8 out of 10).
10. Select the actions that should take place when users receive a passing grade or failing grade on the questions associated with this quiz. For example, use the pop-up menu next to Action and select Go to Slide to have the presentation display a specific slide.
11. Click OK.

The quiz is added to the presentation.
12. Click OK again.
Creating quizzes and questions 45

Creating a multiple-choice question slide

Users answer multiple-choice questions by selecting one or more correct answers from a list. In Breeze Presenter, multiple-choice questions can be branched based on the specific answers users select. For example, in a question with three possible answers, you can set up branching so that selecting the first answer goes to the next slide, the second answer jumps to a specific slide later in the quiz, and the third answer opens a web page.

To create a multiple-choice question slide:

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one in which you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Breeze menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Multiple Choice and do one of the following:
   - To create a multiple-choice question that will be graded, click Create Graded Question.
   - To create a multiple-choice survey question that will not be graded, click Create Survey Question.
6. Accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.
   Tip: If you are creating many of the same type of question in a single presentation, type in unique names for each so they can be distinguished from one another.
7. In the Question text box, type the multiple-choice question exactly as you want it to appear on the slide.
8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.
9. In the Answers area, click Add and enter possible answers. (A multiple-choice question requires at least 2 answers.) If necessary, click Delete to remove an answer from the list.
10. (Optional) Click Advanced to set options for individual answers, such as a custom feedback message, a specific action, or audio. (If you have a particularly long answer, the Advanced Answer Options dialog box gives you more space to type in the answer.)
11. Select the radio button next to the correct answer.
12. In the Type pop-up menu, select whether there are multiple correct responses or a single correct response. (If you select multiple correct responses, be sure to return to step 11 and select the radio buttons next to all correct responses.)
13. In Numbering, use the pop-up menu to select an option for how answers are listed on the quiz slide. You can choose from uppercase letters, lowercase letters, or numbers.
14. Select the Options tab.
15. (Optional) From the Type pop-up menu, select question type: Graded or Survey.

16. Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

17. In the If Correct Answer area, set the following options:

   **Action**  Select one of three actions to occur when a user selects the correct answer:
   - Go to Next Slide advances the presentation to the next slide and is the default action.
   - Go to Slide advances the presentation to a specific slide.
   - Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. Use the pop-up menu to select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

   **Go to Next Slide**  Depending on the option you selected for Action, this text box lets you specify an exact destination.

   **Play Audio Clip**  Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

   **Note:** If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

   **Show Correct Message**  Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don’t want to give any feedback for a correct answer.

18. In the If Wrong Answer area, set the following options:

   **Allow user [#] Attempts**  Use the arrows or type directly into the text box to specify the number of attempts a user can try before another action takes place.

   **Infinite attempts**  Select this option to give users an unlimited number of attempts.

   **Action**  Click the desired action/destination after the last attempt. You can choose from the options listed below.
   - Go to Next Slide advances the presentation to the next slide and is the default action.
   - Go to Slide advances the presentation to a specific slide.
   - Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

   **Go to Next Slide**  Depending on the option you selected for Action, this text box lets you specify an exact destination.
Play Audio Clip  Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message  Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message  Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (e.g., Please try again).

Show Incomplete Message  Select this option to provide a text message for users when they don’t supply an answer (e.g., Please select an answer before continuing).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Breeze menu, select Quiz Manager and click the Default Labels tab.

19. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers  Sends answer information to Breeze or a learning management system.

Quiz  Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID  This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.

Interaction ID  Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.

20. When you finish, click OK.

21. Click OK again to close the Quiz Manager.

The new multiple-choice question slide appears in the designated location in the presentation.

Creating a true or false question slide

Users answer true or false questions by selecting either True or False (or Yes or No) as an answer.

To create a true or false question slide:

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Breeze menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select True/False and do one of the following:
   ■ If you want to create a true or false question that will be graded, click Create Graded Question.
   ■ If you want to create a true or false survey question that will not be graded, click Create Survey Question.

6. Accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.
   Tip: If you are creating many of the same type of question in a single presentation, type in unique name for each so they can be distinguished from one another.

7. In the Question text box, type the true or false question, exactly as you want it to appear on the slide.

8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

9. In the Answers area, establish which answer is correct by clicking on the radio button next to True or False.

10. In the Type pop-up menu, select True or False, or Yes or No.

11. In Numbering, use the pop-up menu to select an option for how answers are listed on the quiz slide. You can choose from uppercase letters, lowercase letters, or numbers.

12. Select the Options tab.

13. (Optional) From the Type pop-up menu, select the question type: Graded or Survey.

14. Select Show clear button to display a button on the question slide that users can click to clear their answers and start over.

15. In the If Correct Answer area, set the following options:
   Action  
   Select one of three actions to occur when a user selects the correct answer:
   ■ Go to Next Slide advances the presentation to the next slide and is the default action.
   ■ Go to Slide advances the presentation to a specific slide.
   ■ Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)
   Go to Next Slide  Depending on the option you selected for Action, this text box lets you specify an exact destination.
Play Audio Clip  Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message  Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for an correct answer.

16. In the If Wrong Answer area, set the following options:

Allow user [#] Attempts  Use the arrows or type directly into the text box to specify the number of attempts a user can try before another action takes place.

Infinite Attempts  Select this option to give users an unlimited number of attempts.

Action  Click the desired action/destination after the last attempt. You can choose from the options listed below.

- Go to Next Slide advances the presentation to the next slide and is the default action.
- Go to Slide advances the presentation to a specific slide.
- Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

Go to Next Slide  Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip  Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message  Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

Show Retry Message  Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (e.g., Please try again).

Show Incomplete Message  Select this option to provide a text message for users when they don't supply an answer (e.g., “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Breeze menu, select Quiz Manager and click the Default Labels tab.
17. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

- **Report Answers**: This option sends answer information to Breeze or a learning management system.
- **Quiz**: Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.
- **Objective ID**: This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.
- **Interaction ID**: Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

**Note**: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.

18. When you finish, click OK.

19. Click OK again to close the Quiz Manager.

The new true or false question slide appears in the designated location in the presentation.

### Creating a fill-in-the-blank question slide

Users answer fill-in-the-blank questions by providing a word or phrase or selecting from a list of possible answers to fill in a blank space within a sentence. In Breeze Presenter, you can provide a list of words or phrases for users to choose from, or have users type in a word or phrase on their own.

**To create a fill-in-the-blank question slide**:

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Breeze menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Fill-in-the-blank and do one of the following:
   - If you want to create a fill-in-the-blank question that will be graded, click Create Graded Question.
   - If you want to create a fill-in-the-blank survey question that will not be graded, click Create Survey Question.
6. Accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.

**Tip**: If you are creating many of the same type of question in a single presentation, type in unique names for each so they can be distinguished from one another.
7. In the Description text box, accept the default text for Description or enter a new description. The description appears on the questions slide in the presentation and should provide users with instructions about how to answer the question.

8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

9. In the Phrase text box, type in the sentence or phrase that will contain a blank space to be completed by users or will contain a blank space with a drop-down list of possible answers for users to select from. Leave out the word or phrase that users should enter. The sentence or phrase can contain multiple blank spaces.

10. Select the word or phrase just before the “blank” in the Phrase text box and click Add Blank.

11. In the Blank Answer dialog box, select an option for how users will choose the correct answer:

   ■ Select The User Will Type in the Answer, Which Will Be Compared to the List Below. if you want users to provide an answer in a text box.

   ■ Select The User Will Select an Answer from the List Below. if you want to provide users with a list possible answers from which they can make a selection.

12. Click Add and enter a word or phrase that correctly fills in the blank space in the question. Click Add and Delete as necessary to create a list of correct answers.

13. (Optional) Select The answer is case-sensitive to require that users type in the correct combination of lowercase and uppercase letters when filling in the blank. For example, if the answer to the question is “Windows” and you select the case-sensitive option, an answer of “windows” is incorrect.

14. Click OK.

15. Select the Options tab.

16. (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

17. Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

18. In the If Correct Answer area, set the following options:

   **Action** Select one of three actions to occur when a user selects the correct answer:

   ■ Go to Next Slide advances the presentation to the next slide and is the default action.

   ■ Go to Slide advances the presentation to a specific slide.

   ■ Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

   **Go to Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.
Play Audio Clip  Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message  Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for a correct answer.

19. In the If Wrong Answer area, set the following options:

Allow user [*] Attempts  Use the arrows or type directly into the text box to specify the number of attempts a user can try before another action takes place.

Infinite Attempts  Select this option to give users an unlimited number of attempts.

Action  Click the desired action/destination after the last attempt. You can choose from the options listed below.

- Go to Next Slide advances the presentation to the next slide and is the default action.
- Go to Slide advances the presentation to a specific slide.
- Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

Go to Next Slide  Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip  Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message  Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

Show Retry Message  Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (e.g., Please try again).

Show Incomplete Message  Select this option to provide a text message for users when they don't supply an answer (e.g., “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Breeze menu, select Quiz Manager and click the Default Labels tab.
20. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

   **Report Answers**  This option sends answer information to Breeze or a learning management system.

   **Quiz**  Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

   **Objective ID**  This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.

   **Interaction ID**  Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

   **Note:** If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.

21. When you finish, click OK.

22. Click OK again to close the Quiz Manager.

   The new fill-in-the-blank question slide appears in the designated location in the presentation.

### Creating a short answer question slide

Users answer short answer questions by providing a word, phrase, or complete sentence as an answer. You can also use this as an essay question and grade it within Breeze or gather extended feedback as a survey question.

**To create a short answer question slide:**

1. In PowerPoint, open a presentation (PPT file).

2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.

3. From the Breeze menu, select Quiz Manager.

4. Select the quiz to which you want to add a question and click Add New Question.

5. In the Question Types dialog box, select Short Answer and do one of the following:

   ■ If you want to create a short answer question that will be graded, click Create Graded Question.

   ■ If you want to create a short answer survey question that will not be graded, click Create Survey Question.

6. Accept the default text for Name or type a new name directly into the text box. The name appears on the question slide in the presentation.

   **Tip:** If you are creating many of the same type of question in a single presentation, type in unique names for each so they can be distinguished from one another.

7. In the Question text box, type the short answer question, exactly as you want it to appear on the slide.
8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

9. In the Acceptable Answers area, click Add and enter words or phrases that are correct answers to the question. Click Add and Delete as necessary to write an appropriate list.

10. (Optional) Select The answer Is Case-sensitive to require that users type in the correct combination of lowercase and uppercase letters when providing a short answer. For example, if the answer to the question is *Windows* and you select the case-sensitive option, an answer of *windows* would be incorrect.

11. Select the Options tab.

12. (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

13. Select Show clear button to display a button on the question slide that users can click to clear their answers and start over.

14. In the If Correct Answer area, set the following options:

   **Action** Select one of three actions to occur when a user selects the correct answer:
   - Go to Next Slide advances the presentation to the next slide and is the default action.
   - Go to Slide advances the presentation to a specific slide.
   - Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

   **Go to Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.

   **Play Audio Clip** Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

   **Note:** If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

   **Show Correct Message** Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for an correct answer.
15. In the If Wrong Answer area, set the following options:

**Allow user [#] Attempts**  Use the arrows or type directly into the text box to specify the number of attempts a user can try before another action takes place.

**Infinite Attempts**  Select this option to give users an unlimited number of attempts.

**Action**  Click the desired action/destination after the last attempt. You can choose from the options listed below.

- **Go to Next Slide** advances the presentation to the next slide and is the default action.
- **Go to Slide** advances the presentation to a specific slide.
- **Open URL** advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

**Go to Next Slide**  Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip**  Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

**Show Error Message**  Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

**Show Retry Message**  Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (e.g., Please try again).

**Show Incomplete Message**  Select this option to provide a text message for users when they don't supply an answer (e.g., Please select an answer before continuing).

*Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Breeze menu, select Quiz Manager and click the Default Labels tab.

16. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers**  This option sends answer information to Breeze or a learning management system.

**Quiz**  Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID**  This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.

**Interaction ID**  Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

*Note:* If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.
17. When you finish, click OK.

18. Click OK again to close the Quiz Manager.

The new short answer question slide appears in the designated location in the presentation. If you are using the short answer question as a graded essay question, you can grade the answer using the Breeze Manager override option. For more information, see the Breeze Manager User Guide.

Creating a matching question slide

Users answer matching questions by matching items in two different lists.

To create a matching question slide:

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Breeze menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Matching and do one of the following:
   - If you want to create a matching question that will be graded, click Create Graded Question.
   - If you want to create a matching survey question that will not be graded, click Create Survey Question.
6. Accept the default text for the Name or type new text directly into the text box. The name appears on the question slide in the presentation.
   
   Tip: If you are creating many of the same type of question in a single presentation, type in unique names for each so they can be distinguished from one another.
7. In the Question text box, type the matching question, exactly as you want it to appear on the slide. For example, “Match the job titles in column 1 with the correct departments in column 2.”
8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.
9. In Answers, click Add under each column and type in the words or phrases to match. (You can also click directly in each column to type in words or phrases.) If necessary, click Delete to remove any answers or click the up and down arrows to move answers up or down a position in the column.
10. To establish the correct matches between answers, click an item in one column, then click an item in the other column, and click Match. (You can also drag items between the two columns to create correct matches.) A line is drawn between the two items to show the relationship.
11. If you need to change the order of items in a column, select an item and then click the up or down arrow below the column to move the item up or down in the list.

12. If you make an error while establishing the correct matches between column items, click Clear matches and start over.

13. In Numbering, use the pop-up menu and select an option for how answers are listed on the quiz slide. You can choose from uppercase letters, lowercase letters, or numbers.

14. Select the Options tab.

15. (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

16. Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

17. In the If Correct Answer area, set the following options:
   - **Action**: Select one of three actions to occur when a user selects the correct answer:
     - **Go to Next Slide** advances the presentation to the next slide and is the default action.
     - **Go to Slide** advances the presentation to a specific slide.
     - **Open URL** advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)
   - **Go to Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.
   - **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)
   - **Note**: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.
   - **Show Correct Message**: Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for a correct answer.

18. In the If Wrong Answer area, set the following options:
   - **Allow user [x] Attempts**: Use the arrows or type directly into the text box to specify the number of attempts a user can try before another action takes place.
   - **Infinite Attempts**: Select this option to give users an unlimited number of attempts.
Action  
Click the desired action/destination after the last attempt. You can choose from the options listed below.

- **Go to Next Slide** advances the presentation to the next slide and is the default action.
- **Go to Slide** advances the presentation to a specific slide.
- **Open URL** advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

**Go to Next Slide**  
Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip**  
Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

**Show Error Message**  
Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don’t want to give any feedback for an incorrect answer.

**Show Retry Message**  
Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (e.g., Please try again).

**Show Incomplete Message**  
Select this option to provide a text message for users when they don’t supply an answer (e.g., “Please select an answer before continuing.”).

*Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Breeze menu, select Quiz Manager and click the Default Labels tab.

19. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers**  
This option sends answer information to Breeze or a learning management system.

**Quiz**  
Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID**  
This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.

**Interaction ID**  
Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

*Note:* If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.

20. When you finish, click OK.

21. Click OK again to close the Quiz Manager.

The new matching question slide appears in the designated location in the presentation.
Creating a rating scale (likert) question slide

Users answer rating scale questions by specifying their level of agreement to a statement. For example, a user may be given the question, “This presentation provided me with valuable information.” and asked if they disagree, somewhat disagree, are neutral, somewhat agree, or agree.

Rating scale questions are always survey questions and are therefore not graded. You cannot assign a rating scale question with a point value, nor can you creating branching for a correct or incorrect answer (since it’s a survey question and does not have a correct or incorrect answer). You can, however, decide what happens after the user completes the rating scale question, such as continuing to the next slide or displaying a URL.

To create a rating scale question slide:

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question slide. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Breeze menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Rating Scale (Likert).
6. Click Create Survey Question.
7. Accept the default text for the Name or type new text directly into the text box. The name appears on the question slide in the presentation.
8. Accept the default text for Description or type a new description directly into the text box. The description appears on the question slide in the presentation and should provide users with instructions about how to answer the question.
9. In the Questions area, click Add and type a likert question directly into the text box. (You can add up to five separate likert questions on a single slide.)
10. In the Answers area, you can accept the default answer text, edit the text, delete a type, and add a new answer types. To edit the text, double-click existing text such as “Neutral” and type new text. To delete an answer type, select a type and click Delete. To add an answer type, click Add and type new text. (You can have a total of five answer types.)
11. Select the Options tab.
12. Select Show clear button to display a button on the question slide that users can click to clear their answers and start over.
13. In the After Survey question area, set the following options:

   **Action**  Select one of three actions to occur when a user selects the correct answer:
   - Go to Next Slide advances the presentation to the next slide and is the default action.
   - Go to Slide advances the presentation to a specific slide.
   - Open URL advances the presentation to a specific URL on the Internet. Enter the URL in the Open URL text box. From the pop-up menu, select the window in which the URL should appear; choose from Current or New. (Current replaces your presentation in the web browser with the URL address you specify. New opens the URL address in a new, separate window.)

   **Go to Next Slide**  Depending on the option you selected for Action, this text box lets you specify an exact destination.

   **Play Audio Clip**  Select this option to import an audio file or record a new audio file that should play when the question is answered. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

   **Note:** If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

14. Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

   **Report Answers**  This option sends answer information to Breeze or a learning management system.

   **Quiz**  Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

   **Objective ID**  This is a number automatically created when you create a quiz. This number is used to report scores from Breeze Presenter presentations that will be tracked in Breeze or a learning management system.

   **Interaction ID**  Accept the default number or type a new number directly into the text box. If you want the Breeze Presenter presentation to send tracking information to Breeze, you must use the Interaction ID specified by Breeze.

   **Note:** If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Breeze.

15. When you finish, click OK.

16. Click OK again to close the Quiz Manager.

   The new rating scale question slide appears in the designated location in the presentation.
Changing question slide order

After you have created question slides in a presentation, you can change their order. The easiest method is to move the slides in PowerPoint.

To change question slide order:
1. In PowerPoint, open a presentation (PPT file).
2. In the Outline pane, drag the slide icon to a new location.

The next time you open the Quiz Manager (from the Breeze menu), the new question order is displayed.

Deleting question slides

You can delete a question slide at any time. The easiest method is to delete the slide in PowerPoint.

To delete a question slide:
1. In PowerPoint, open a presentation (PPT file).
2. In the Outline pane, select a slide and click Delete.

The next time you open the Quiz Manager (from the Breeze menu), the question slide will not be listed.

Setting reporting options

Breeze Presenter offers output options for presentations with e-learning elements. For example, you can create presentations that are SCORM or AICC compliant for use within a learning management system.

Reporting options such as what kind of data to collect and how the data is reported are set for a quiz. You can, however, select whether to report interaction data to a learning management system at the quiz level or the question level. If the two settings are different, the setting for the question is used. For example, a quiz is set to report interactions, but a question within the quiz is not set to report interactions. In this case, the question does not get reported. The question will, however, be included in the overall numerical score for the quiz if the question is a graded question. (Because the question was not set to report interactions, the exact answer the user selected does not get reported.)

To set e-learning output options:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. In the Quiz Manager dialog box, select a quiz and click the Reporting tab.
4. Select Enable Reporting for This Presentation.
5. Select the main learning management system standard you want to use:

- Breeze
- AICC
  
  Note: If you select AICC, four course structure files are created. For more information, see "Editing AICC course structure files (CSF)" on page 67.
- SCORM
  
  Note: If you select SCORM, click Manifest to set options for creating a manifest file, required by many third-party learning management systems. For more information, see "Creating a manifest file for SCORM" on page 65.

6. Choose how to report data:

- Report to Breeze reports quiz reporting data to the Breeze server. For example, in a presentation containing quizzes, a passing grade is reported to Breeze if all questions in all quizzes were answered completely and the user achieved a passing score. Or, if a presentation does not contain quizzes, a grade of complete is sent to Breeze when the user has viewed all slides.

- Report Quiz Results Only reports quiz results only in the presentation itself. (No data will be sent to a learning management system.) For example, if a presentation contains quizzes, and any quiz is assigned a passing score that is greater than 0, when a user completes all quizzes with a passing score, a passing grade is reported. Or, if a presentation does not contain quizzes, a grade of complete is reported when the user has viewed all slides.

- Report User Access Only reports if users have opened the presentation and viewed one slide.

- Report Quiz Results and Slide Views reports quiz results only in the presentation itself (no data will be sent to a learning management system) and how many individual slides users viewed. For example, if a presentation contains quizzes, two items are reported. First, if any quiz is assigned a passing score that is greater than 0, when a user completes all quizzes with a passing score, a passing grade is reported. Second, a grade of complete is sent to Breeze when the user has viewed all (100%) of the slides. Or, if a presentation does not contain quizzes, send a grade of complete when the user has viewed all (100%) of the slides.

- Report Slide Views Only reports how many individual slides users viewed. The number is given as a percentage. For example, if a user opens a presentation and views 8 out of 10 slides, a slide view of 80% is reported.

- Slide View Completion % lets you set the percentage of slides that must be viewed by a user for them to complete the presentation. For example, if you have a presentation that contains 10 slides and you set the Slide View Completion percentage to 80, users who view 8 out of the 10 slides will have “completed” the presentation. (This option is only available if you select the Report Quiz Results and Slide Views or Report Slide Views Only option.)

7. Select how pass and fail information is reported. (If you selected the Report to Breeze option in step 6, settings in this Report Pass or Fail area are ignored, and all information is sent to Breeze.)

- Report Complete/Incomplete reports results as either complete or incomplete.
- Report Pass/Fail reports results as either pass or fail.
- Report Status as Defined by Report Data reports status using the selections made in the Choose Report Data area of this dialog box.
8. Select how scores are reported to your learning management system. (If you selected the Report to Breeze option in step 6, settings in this Report score to LMS area are ignored and all information is sent to Breeze.)

   **Score** specifies that scores are reported as a numerical score. For example, 8 out of 10 correct.
   
   **Percent** specifies that scores are reported as a percentage. For example, 85% correct.

9. Select a reporting level. (If you selected the Report to Breeze option in step 6, settings in this Reporting level area are ignored and all information is sent to Breeze.)

   **Only Report the Score** specifies that only scores are reported to the learning management system.
   
   **Report Interactions and the Score** specifies that scores and interactions are both reported to the learning management system.

10. (Optional) Click Settings to customize how data is sent and formatted to a learning management system. (For more information, see “Customizing learning management system settings” on page 67.

11. Click OK.

### Setting an e-learning pass rate for a quiz

When you place quizzes in a presentation, you set a pass rate for users. The pass rate is a percentage or numeric value that users must reach in order to pass the quizzes. For example, setting a pass of 80% requires users to get 80% of questions correct in order to pass.

**To set an e-learning pass rate:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. In the Quiz Manager, select a quiz and click Edit Quiz Settings.
4. Click the Pass or Fail Options tab.
5. Select a Pass/Fail option:
   
   **“#” % or more of total score to pass** Enter a percentage value that students must meet in order to pass. For example, if you enter a value of 80, students must provide correct answers to 80% of the questions. (In a quiz containing 10 questions, at least 8 must be answered correctly).
   
   **“#” or more of total score to pass** Enter a numeric value that students must meet in order to pass. For example, if you enter a value of 8, students must provide correct answers to 8 questions in the quiz.
6. Click OK.
Setting how e-learning scores are displayed

You can set the way the quiz score is reported to users.

To set e-learning scoring display:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. In the Quiz Manager dialog box, select a quiz and click Edit Quiz Settings.
4. Click on the Quiz Settings tab.
5. Select Show Score at End of Quiz.
6. Click Quiz Result Messages.
7. Select a score option:
   - **Display Score** specifies that the numerical score is displayed.
   - **Display Percent Score** specifies that a score as a percentage of total is displayed.
   - **Tally Correct** specifies that a score in tally form (for example, "7 out of 10 correct") is displayed.
8. Click OK three times to close all of the dialog boxes.

Using feedback messages in quizzes and questions

Because quizzes are interactive, it’s important to guide users through any question slides you place in projects. An easy way to communicate with users is through feedback messages. These are messages that display, for example, when a user selects a correct answer or incorrect answer.

Feedback messages are set for individual questions, so you can choose to include messages in some questions or all questions within a quiz.

To include or not include feedback message text in a question:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. Select a question and click Edit Question.
4. Click the Options tab.
5. In the If Correct Answer area, select the Show Correct Message option to display a message for users confirming that they selected the correct answer. Deselect the Show Correct Message option if you do not want to display a message for users when they select the correct answer.
6. In the If Wrong Answer area, select the Show Error Message option to display a message for users stating that they selected the incorrect answer. Deselect the Show Error Message option if you do not want to display a message for users when they select the incorrect answer.
7. In the If Wrong Answer area, select the Show Retry Message option to display a message for users when they select the incorrect answer, but have remaining answer attempts available. Deselect the Show Retry Message option if you do not want to display a message for users when they select the incorrect answer, but have remaining answer attempts available.
8. In the If Wrong Answer area, select the Show Incomplete Message option to display a message for users when they do not supply an answer to a required question. Deselect the Show Incomplete Message option if you do not want to display a message for users when they do not supply an answer to a required question.

9. Click OK two times to close all of the dialog boxes.

Breeze Presenter provides default text for feedback messages that are displayed for users, but you can edit the text at any time. The text is set at the quiz level so that all questions within a quiz display the same feedback messages.

**To edit feedback message text in a quiz:**
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. On any quiz, click Edit Quiz Settings.
5. Accept the default text or type new text directly into the text boxes for Correct, Incomplete, and Incorrect feedback messages.
6. Click OK three times to close all of the dialog boxes.

*Note:* If you change the default labels, the question feedback messages also change for questions that have already been created.

**About using Breeze Presenter presentations with a learning management system**

Presentations created with Breeze Presenter integrate especially well with the Breeze learning management system, but you can use Breeze Presenter presentations with any learning management system. If you are going use a presentation with a third-party learning management system, the following three sections explain how to create a manifest file, how AICC course structure files can be edited, and how to customize learning management systems settings:

- “Creating a manifest file for SCORM”
- “Editing AICC course structure files (CSF)” on page 67
- “Customizing learning management system settings” on page 67

**Creating a manifest file for SCORM**

Breeze Presenter contains an important e-learning feature that creates a manifest file. If you want to package a Breeze Presenter presentation as an e-learning course that can be administered and launched from a SCORM 1.2 or 2004 conforment learning management system, you may need a manifest file.

*Note:* If you are publishing to Breeze, a manifest file is automatically created named breeze-manifest.xml. This XML file is used to upload the presentation into the Breeze server. You do not need to follow the procedure below to create a SCORM manifest file.
The manifest file that Breeze Presenter creates is named imsmanifest.xml and contains references to all content resources. The XML file uses predefined XML tags to describe the package components, structure, and special behaviors. The file works behind the scenes to properly integrate presentations with your learning management system and track quiz data.

To create a SCORM manifest file:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. Click the Reporting tab.
4. Select Enable Reporting for This Presentation.
5. Under Learning Management System (LMS), select SCORM.
6. Click Manifest.
7. Set the SCORM Version by selecting 1.2 or 2004 from the pop-up menu.
8. Set the following manifest options:
   - **Identifier** (Required) The identifier is used by the LMS to identify different manifests. A default identifier based on the name of your Breeze Presenter presentation is automatically added to this text box. You can change the identifier at any time by selecting the text and typing in new text.
   - **Title** (Required) The title can be viewed by students using the LMS. A default title based on the name of your Breeze Presenter presentation is automatically added to this text box. You can change the title at any time by selecting the text and typing in new text.
   - **Description** (Required) Text used by the LMS to describe different courses to users. A default description based on the name of your Breeze Presenter presentation is automatically added to this text box. You can edit the description at any time.
   - **Version** (Required) The version specifies a number that can be used to differentiate manifests with the same identifier.
   - **Duration** (Optional) Select this option to specify the approximate time it takes to work with this particular Breeze Presenter presentation. Set the time in the following format: hh:mm:ss.
   - **Subject** (Optional) Select this option to write a short description of the Breeze Presenter presentation using keywords or phrases.
   - **SCO Identifier** (Required) The identifier is used by the LMS to identify different Shareable Content Objects (SCO). A default identifier based on the name of your Breeze Presenter presentation is automatically added to this text box. You can change the identifier at any time by selecting the text and typing in new text.
   - **Note:** If you type in a new identifier, do not use any spaces within the identifier.
   - **Title** (Required) A default title based on the name of your Breeze Presenter presentation is automatically added to this text box. You can change the title at any time by selecting the text and typing in new text.
**Mastery Score**  (Optional) Select this option to specify a passing score for the Breeze Presenter presentation. The score should be a number between 0 and 100. Only Breeze Presenter presentations containing score-reporting objects such as quiz slides, text entry boxes, click boxes, or buttons, need to include a mastery score.

**Time Allowed**  (Optional) Select this option to specify the maximum amount of time allowed to complete the Breeze Presenter presentation.

**Time Limit Action**  (Optional) Select this option to specify the action that should be taken when the maximum time allowed to complete the presentation has been exceeded. From the pop-up menu, select one of the four options: Exit with Message, Exit Without Message, Continue with Message, or Continue Without Message.

**Launch Data**  (Optional) Select this option to specify initialization data expected by the resource.

9. Click OK.

To see the manifest file, you should publish your Breeze Presenter presentation locally to create a Flash SWF file and a manifest file. If you used the default save location, you can use Windows Explorer to navigate to the SWF file and imsmanifest.xml file in My Documents\My Breeze Presentations\Name of Presentation folder. If you published the presentation to a different folder, navigate to that location to see the manifest file.

**Editing AICC course structure files (CSF)**

If you select the Breeze or AICC option when setting reporting options, four AICC course structure files are created: presenter.au, presenter.crs, presenter.cst, and presenter.des. The files are created with default values, but the values can be edited manually. For more information, see the IAICC website at www.aicc.org.

**Customizing learning management system settings**

Breeze Presenter offers several advanced settings for how presentations integrate with learning management systems (LMS). The settings let you specify what data is sent to the LMS and how the data is formatted. Typically, these settings are used by advanced LMS users or requested by LMS administrators.

**Note:** The settings are used by third-party learning management systems; they do not affect the data sent from Breeze Presenter to Breeze.

**To set advanced learning management system settings:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Quiz Manager.
3. Click the Reporting tab.
4. Click Settings.
5. In the LMS Customization Settings area, set the following options:

**Never Send Resume Data**  
Select this option if you do not want resume data to be sent to your LMS. This might be useful if your LMS does not support resume data or another mechanism to prevent users from returning to a quiz they started, but did not finish, across multiple sessions. For example, a user completes 4 questions out of 8 and then closes the presentation. If you select this option, when the user opens the presentation again they must provide answers to all 8 questions—their answers from the first session are not remembered in the Breeze Presenter presentation. This option can be used when publishing and playing back content from any AICC or SCORM compliant learning management system.

**Note:** Presentations that are part of a Breeze training course or curriculum are always automatically resumed. If the presentation is viewed using the Content tab, it is never resumed/

**Escape Version and Session ID**  
This option is selected by default. Keep this option selected if you want Breeze Presenter to URL-encode (escape) the version and session ID when sending data to an AICC compliant learning management system. This is useful if your learning management system does not accept URL-encoded information for these fields. Deselect this option if you do not want to URL-encode (escape) the version and session ID.

**Don’t Escape Characters**  
This option lets you specify that Breeze Presenter should not URL-encode (escape) the value fields in parameters when data is sent to an AICC compliant learning management system. In the text box, type in the characters (without any delimiters such as spaces or commas) that the learning management system does not want escaped. For example, if the LMS does not want any numbers escaped, type in 0123456789.

6. Click OK to finish setting the custom LMS settings and close the Quiz Manager.
You can customize how your presentations look when they are viewed by presentation users. Presentations appear in the Breeze Presenter viewer, a full-featured, multipaneled user interface. Breeze Presenter gives you many options for customizing viewer elements such as colors, tabs, functionality, custom graphics, font style, and other design elements that users see when they view the presentation.

Working with themes in presentations

The primary way to design how presentations appear in the Breeze Presenter viewer is through the use of themes. Themes serve as the “container” for your presentation, and let you add static images, colors, and sound to create dynamic and interactive presentations. You can add a theme at any time. Try using different themes until you achieve the right look you want. You can reuse the same theme for each presentation you create or design new themes.

The following theme topics are discussed in this chapter:

- “Selecting a presentation theme” on page 70
- “Creating a custom theme” on page 70
- “Changing text labels in a theme” on page 71
- “Changing theme colors” on page 72
- “Showing and hiding panes in a theme” on page 73
- “Setting a default pane for a theme” on page 73
- “Choosing a location for the sidebar” on page 74
- “Setting the presentation to appear in full-screen mode” on page 75
- “Setting presenter options for a theme” on page 76
Selecting a presentation theme

The default theme assigned to presentations is Sage, but you can change the theme at any time.

To select a presentation theme:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Theme Name pop-up menu, select a theme.
   The preview window displays the new theme.
4. Change theme options as desired.
5. Click OK to close the Theme Editor.

Creating a custom theme

You can create a custom theme by selecting one of the default themes, making changes, and saving the new theme with a different name. For example, you can start with the default theme, Sage, change the font color to dark green, and then save the new theme as Sage Modified. After you create a custom theme, it appears in the Theme name pop-up menu and can be used with other presentations.

To create a custom theme:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. Make changes as desired. For instance, click Text Labels to change the text in different areas of the theme, or click Change Theme Colors to select custom colors for the font and background.
4. Click the Save as button and specify a name for the new theme.
5. Click OK.

The new theme appears in the Theme Name pop-up menu in the Theme Editor and can be used when publishing presentations.
Changing text labels in a theme

Text labels are the words that appear in a theme, such as button text and tab names. You can edit text labels in a theme at any time.

In this example, the pane text has been changed to Summary, Images, Comments, and Find.

To change text labels in a theme:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. Click the Text Labels button.
4. Click the Language pop-up menu and select a language for the text labels.
   Note: Breeze presentations detect the language of a user’s operating system and automatically display the text labels in the user’s native language if their computer’s language is set to German, French, Korean, or Japanese. Otherwise, English text labels appear.
5. As necessary, change the text labels for any element of the presentation theme. For example, you can change the text that displays on buttons or panes.
6. Click OK.
   The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.
7. Click OK.
Changing theme colors

You can change the colors that appear in a theme, including the background color and glow color. You can also specify a background image to use in a theme.

**To change theme colors:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. Click the Change Theme Colors button. To change a color, click once on any of the color bars. You can change any of the following color options:
   - **Theme Color** Click this color bar to change the color of the theme sidebar and toolbar.
   - **Glow Color** Click this color bar to change the color that appears when users hover their mouse over slides in the Outline pane and thumbnail images in the Thumb pane.
   - **Font Color** Click this color bar to change the color of the text in the theme.
   - **Background Color** Click this color bar to change the color of the background area that appears behind the slides, sidebar, and toolbar.
   - **Background Image** Click the Browse button to navigate to an image file (in .JPG format) to use as the background. The background is the area that appears behind the slides, sidebar, and toolbar.
4. Click OK.
   The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.
5. Click OK.

Deleting a theme

You can delete a custom theme at any time, however, the default themes included with Breeze Presenter, such as Sage and Sapphire, cannot be removed.

**To delete a theme:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Theme Name pop-up menu, select the theme you want to remove.
4. Click Delete.
5. A confirmation dialog box appears. Click Yes.
6. Click OK.
Showing and hiding panes in a theme

Panes appear in the sidebar of a theme. The default location of the sidebar is on the right side, but the location can be changed. You can select which panes appear in the theme and which are hidden. For example, you might want to include the Outline and Search panes, but hide the Thumbnail and Notes panes.

To show and hide theme panes:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. In the General Options area on the left, select the panes that should appear and deselect the panes you want to hide.
   The theme preview on the right side updates to reflect your choices.
4. Click OK.

Here is an example of a theme with only two panes, instead of the default four, in the sidebar.

Setting a default pane for a theme

Panes are part of a theme and appear in the sidebar. If you have more than one pane in a theme, the panes are layered on top of one another with a tab at the top containing the name of the pane. You can select the pane that appears in front of the others. If you are displaying all of the panes, select from Outline, Thumbnail, Notes, and Search.
To set a default theme pane:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Panes pop-up menu, select the pane that should appear by default when the presentation appears.
   The theme preview on the right side is updated to reflect your choices.
4. Click OK.

Choosing a location for the sidebar
The sidebar in a theme contains presenter information, panes such as Outline and Search, and presentation timing information. You can position the sidebar on the right (default) or left side of the theme.

To choose a location for the sidebar:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Location of Layout pop-up menu, select Left or Right.
   The theme preview on the right side is updated to reflect your choices.
4. Click OK.
Setting the presentation to appear in full-screen mode

You can choose to have your presentation open normally or in full-screen mode. Normally, the presentation appears with the toolbar and the sidebar. As an alternative, you can have the presentation open in full-screen mode with only a small, modified toolbar appearing in the bottom right corner.

When the presentation is published using the default setting, the toolbar and the sidebar are displayed.

When the presentation is published using the full-screen setting, the modified toolbar is displayed.
To have a presentation open in full-screen mode:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
3. The Theme Editor dialog box appears.
4. From the Default Mode on Startup pop-up menu, select Default or Fullscreen.
5. Click OK.

Setting presenter options for a theme
You can select exactly which presenter options appear in a theme. For example, you might want
the presenter name and photo to appear, but not a biography (bio) or contact information.
To set presenter options for a theme:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. In the Presenter Options area, select the options to include in your theme:
   - **Presenter Photo** Select to include a presenter photo in the published presentation.
   - **Presenter Name** Select to include the presenter’s name in the published presentation.
   - **Presenter Logo** Select to include a logo in the published presentation.
   - **Presenter Bio** Select to include a link to a presenter biography.
   - **Presenter Contact Information** Select to include a link to presenter contact information
     such as a phone number or e-mail address.
   - **Presenter Title** Select to include the presenter’s title, such as Director of Human Resources.
4. Click OK.

Using PowerPoint templates for Breeze Presenter
In Breeze Presenter presentations, the slide background is determined by settings in PowerPoint.
You can customize the background of the slides in a presentation by using PowerPoint design
templates. When you apply a design template, all slides in the presentation are assigned the design
template background.
For example, you might create a presentation in PowerPoint using the design template named
Technology, add the red theme named Stop Sign in the Breeze Presenter Theme Editor, publish
the presentation to Breeze, and view the presentation. You notice that the theme clashes with the slide
background of the Technology design template.
Follow the procedure below that corresponds to the version of PowerPoint installed on your
computer. (To check which version of PowerPoint you have, open PowerPoint, click on the Help
menu, and select About Microsoft PowerPoint.)
To use PowerPoint 2000 templates as slide backgrounds:
1. In PowerPoint, open a presentation (PPT file).
2. From the Format menu, select Apply Design Template.
   
   **Note:** If the Apply Design Template dialog box does not open to the Presentation Designs location on your computer, browse to the location at Program Files\Microsoft Office\Templates\Presentation Designs.

3. Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.
4. To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Breeze menu > Publish. Select My Computer and click Publish.)

To use PowerPoint 2003 templates as slide backgrounds:
1. In PowerPoint, open a presentation (PPT file).
2. From the Format menu, select Slide Design.
3. Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.
4. To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Breeze menu > Publish. Select My Computer and click Publish.)

To use PowerPoint XP templates as slide backgrounds:
1. In PowerPoint, open a presentation (PPT file).
2. From the Format menu, select Slide Design.
3. Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.
4. To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Breeze menu > Publish. Select My Computer and click Publish.)

Adding a logo

You can add a custom logo to display in the Breeze Presenter viewer. This is a great way to customize your presentations so they look like other multimedia and publications your organization produces.

To add a custom logo:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Click the Presenter tab and do one of the following:
   - Add a new presenter by clicking Add.
   - Select an existing presenter and click Edit.
4. Next to the Logo text box, click Browse.

5. Navigate to the location of the logo file you want to use (JPG or PNG format).
   
   **Note:** A logo size of 148 x 52 (pixels) is recommended so that the logo appears properly in the theme and the Breeze Presenter viewer.

6. Select the file and click Open.
   
   The name of the file is displayed in the Logo text box and a preview of the logo appears on the right side.

7. Click OK.

8. To preview the custom logo, publish your presentation locally and view the results. (In PowerPoint, select Breeze menu > Publish. Select My Computer and click Publish.)

**Including slide notes in presentations**

You can include extra notes about a slide in your final presentation. Users view the notes by clicking on the Notes pane in the viewer sidebar. Slide notes are a good location for extra information about a slide such as numerical details, supporting materials, or footnote text. You can also use slide notes to communicate with users who do not have audio capabilities or are hearing impaired. You create slide notes in PowerPoint.

**Note:** The notes appear in the Breeze Presenter viewer as unformatted text. Any formatting applied to notes in the PowerPoint note pane is ignored.

**To create slide notes:**

1. In PowerPoint, open a presentation (PPT file).
2. Navigate to a slide for which you want to add a note.
3. Ensure that you are in Normal or Notes Page view.
4. Type note text directly into the notes area under the slide. (If you are in Normal view, but cannot see the notes area, it might be collapsed. Click the separator bar until the pointer changes to allow you to drag the separator bar. Drag up to display the notes area.)

To view the notes area, move the mouse pointer over the separator bar until an equal sign with two arrows appears, then drag up.
5. You can preview the notes by publishing your presentation locally, viewing the results, and clicking on the Slide Notes pane in the sidebar. (To publish locally, in PowerPoint, select Breeze menu > Publish. Select My Computer and click Publish.)

This example shows PowerPoint slide notes in the Notes pane of the sidebar.

**Automatically playing a presentation**

You can set an option so that a presentation automatically plays when it’s opened, or you can require that a presenter or user click the Play button in the toolbar to start the presentation.

**To have the presentation automatically play when it’s opened:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Click the Settings tab.
4. Select Auto Play Presentation on Start.
   
   If this option is not selected, a presenter or users must click the Play button in the toolbar to start the presentation.
5. Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.
Looping a presentation

You can set your presentation to play once and then stop (the default setting), or to loop and replay continuously.

To set the presentation to loop:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Click the Settings tab.
4. Select Loop Presentation.
5. Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.

Changing slide display timing

You can change the display time for slides without audio. (By default, slides with audio play for the length of the associated audio file.) This is useful for controlling the overall speed at which presentations without audio play.

To change slide display timing:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Click the Settings tab.
4. In the Time to Wait for Slides Without Audio text box, enter a new number (in seconds) or use the up and down arrows to set a new number.
5. Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.
CHAPTER 6
Working with Breeze Servers

For others to view your presentation, you must publish the presentation to a Macromedia Breeze server. Users can see your presentation in the viewer within Breeze Meeting, as part of a course or curriculum in Breeze Training, or with a URL provided by the Content library. The Breeze Presenter viewer delivers rich-media content in a powerful, interactive format. The multipaneled interface allows the user to choose from a wide range of options to support the viewing experience.

About Macromedia Breeze

Macromedia Breeze is a web communication system that lets you quickly and easily view presentations, attend meetings, and receive training over the Internet using the familiar PowerPoint application, web browsers, and Macromedia Flash Player.

Breeze includes a set of components that provides an integrated solution. Breeze can be deployed with some or all of these components:

- **Breeze Meeting** lets you view and participate in a meeting over the Internet in real time.
- **Breeze Training** lets you participate in online training systems including integrated surveys, tracking, analysis, and course management.
- **Breeze Events** provides tools to manage the full cycle of an event, from registration and qualification of users to post-event follow-up.

About Breeze Meeting

Breeze Meeting is an online application that lets you meet instantly over the Internet with colleagues, vendors, or instructors. Using Macromedia Flash Player and a browser, you can enter, view, and participate in an online meeting. From within a meeting, you can view media rich content including Microsoft PowerPoint slides, digital video, FlashPaper documents, Flash SWF files, Captivate simulations, and other types of media.

You can interact and collaborate with other meeting attendees using live video and voice broadcasts, chat messages, onscreen whiteboard drawings and annotations, and demonstrations of applications on the presenter’s computer. You can participate in a meeting room poll that immediately displays the results in the meeting.
When you enter a meeting room in Breeze, you see the meeting room stage, which typically contains several panels (pods) of different sizes. One pod might contain a Breeze presentation while another lists the name and status of each meeting room attendee. Certain pods serve a specific function such as broadcasting live video and audio from the presenter to meeting room attendees.

A meeting takes place during a given time period and then it is over. A Breeze meeting room exists before a meeting and continues to exist after the meeting. You may enter the same meeting room from one meeting to the next. If a meeting room is left open between meetings, you can enter a meeting at anytime to view content.

Additional Macromedia Breeze resources

More information is available on the Breeze Product Center and Breeze Support Center websites:

**Breeze Product Center**  The Breeze Product Center is updated regularly with the latest information on Breeze, including FAQs, white papers, testimonials, and tips. Check the website often for the latest news on Breeze at www.macromedia.com/go/breeze.

**Breeze Support Center**  The Breeze Support Center contains the latest support information, including TechNotes, Breeze Presentation tutorials, and support program details. Check the website often for the latest Breeze support information at www.macromedia.com/go/breeze/support.

**Breeze Resource Center**  The Breeze Resource Center helps you quickly get starting using the different features in Breeze. Check the website often for the latest Breeze support information at www.macromedia.com/go/breeze_resources.

Accessing your Breeze account

You can access your Breeze account quickly and easily from Breeze Presenter.

To access your Breeze account:

- From the Breeze menu, select Manage Account.

  Your default web browser opens and the Breeze login page appears.

*Note:* You can change which Breeze server appears when Manage Account is selected by clicking Breeze menu > Preferences, and in the Breeze Server tab, selecting a different server in the publishing list, and clicking Close.

Managing the Breeze server publishing list

Breeze Presenter provides you with an easy way to maintain a list of Breeze servers that you publish to regularly. You can add one or several Breeze servers to the publishing list. After a server has been added to the list, it's easy and quick to publish to that server.

Before you can publish to a Breeze server, you need to add information, such as a name and URL address, to the publishing list. You can add as many Breeze servers to the list as necessary.
To add a Breeze server to the publishing list:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Click the Breeze Server tab.
4. Click the Add button.
5. In the Name text box, enter a unique name for the server. (This is only used locally to help you distinguish between multiple servers easily.)
6. In the URL text box, enter the exact URL address of the server.
   **Note:** The URL you enter here is the same URL you use to log in to Breeze Manager. If you do not know this URL, consult your Breeze administrator.
7. Click OK.
   The server now appears in the publishing list and you can select it in the Publish dialog box.
   **Note:** The server that is highlighted in the publishing list is the one that will be used when you publish to Breeze.
8. Click Close.

After you have added a Breeze server to the publishing list, you can edit the server name or URL at any time.

To edit a Breeze server in the publishing list:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Click the Breeze Server tab.
4. Select a server in the list and click Edit.
5. Make any necessary changes to the server name or URL.
6. Click OK.
7. Click Close.

You can remove a Breeze server from the publishing list.

To remove a Breeze server from the publishing list:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Click the Breeze Server tab.
4. Select a server from the list and click Delete.
5. Click OK.
6. Click Close.
Publishing to a Macromedia Breeze server

After creating and previewing your presentation, you can publish the presentation directly to a Breeze server in your publishing list. (For more information, see “Managing the Breeze server publishing list” on page 84.) You can fully integrate Breeze Presenter presentations with Breeze so that, for example, presentations containing quizzes can have quiz results automatically sent to and managed by a Breeze server.

Note: To publish to a Breeze server, you must be connected to the Internet and have a Breeze account.

When you publish to Breeze, the presentation is published to the Content library. The presentation can be taken from the Content library, and pulled into Breeze Meeting or Breeze Training.

Publishing a presentation to a Breeze server or to the Content library involves these general steps:

- Selecting a Breeze server
- Logging in to Breeze
- Selecting a presentation save location
- Entering presentation information
- Setting permissions

Selecting a Breeze server

The first step in publishing a presentation to a Breeze server, is to select the server the server from the publishing list to which you want to publish.

To select a server from the publishing list:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Publish.
3. On the left side of the Publish dialog box, select Breeze Server.
4. Check that the information listed under Breeze Server is correct. If the information is not correct or if you need to publish to a different server, click Change Server.
5. (Optional) Check the Presentation Information area on the right side. If you want to edit any of the options, such as Presenter Name or Loop Presentation, click Settings.
6. (Optional) If you want to publish the presentation source files (PPT and PPC) along with the SWF file, select Upload Source Files to the Server. This option is useful if multiple authors are working on a presentation or if you think the presentation will need to be updated later and you want to keep all of the files stored in one location.
7. (Optional) You can change the theme by clicking on the Theme pop-up menu and selecting a different theme. (The preview is updated to reflect your choices.)
8. Click Publish.

The presentation is created and the Macromedia Breeze Login screen appears.

The next section describes how to log in to your Breeze account.
Logging in to Breeze

The next step in publishing a presentation is to log in to your Breeze account. You must have an account and the correct security permissions before publishing a presentation. (To obtain permission to create and update presentations, contact your Breeze administrator.)

To log in to Breeze:

1. On the Macromedia Breeze Login screen, log in to Breeze using your login name (usually your account e-mail address).
2. Enter your password.
3. Click Login.

The Set Presentation Location dialog box appears.

The next section explains how to select a location in which to save a presentation.

Selecting a presentation save location

The third step in publishing a presentation is to select a location in your Breeze account in which to store the presentation. After you log in to Breeze, your personal user folder in the Content library appears. Select a location in your Breeze Account library for the presentation.

Note: The Content library displays only your Breeze presentations. Other Breeze content, including SWF files, FLA files, and JPG files, are not displayed when you view the Content library.

Note: If you have already published the presentation to the server, you are prompted to save over the previous version or to save the presentation to a new location.

To select a save location in Breeze for a presentation:

1. In the Set Presentation Location dialog box, navigate to the folder within your Breeze Account library in which to store the presentation.
   - To open a folder and display its contents, click the name of a folder. The folders and files within that folder are displayed. The navigation path for links near the top of the browser window is updated to indicate the directory path to the selected folder.
   - To publish changes to a presentation already located in the folder, click Update Existing Presentation. The new version of the presentation overwrites the existing presentation.
   - To create a new folder, navigate to the location where you want to add a new folder, click the New Folder button, enter a name for the new folder, and click Save.
     
     Note: You can create folders only if you have manage permissions for the parent folder.
   - To move up to the parent folder (the folder one level above the current folder), click the Up One Level button in the navigation bar above the content list.

2. Click Publish to This Folder.

The Content Information dialog box appears.

The next section explains how to enter descriptive information for the presentation.
Entering presentation information

The fourth step in publishing a presentation is to provide identification information about the presentation. You must specify a title for the presentation. You also have the option of adding a custom URL to view the presentation and a brief description.

**To specify presentation information:**

1. In the Content Information dialog box, enter a unique name for the presentation in the Title text box.

2. (Optional) In the Custom URL text box, you can create your own URL to view the presentation. This option is useful if you want to create a URL to view the presentation that can be remembered easily. If you leave this text box blank, Breeze automatically creates a generic, but unique, URL for the presentation.

3. (Optional) In the Summary text box, type in a short description of the presentation. (Maximum length of the summary is 750 characters.)

4. Click Next.

The Set Permissions dialog box appears.

The final step in the publishing process is to set permissions for who can view the presentation.

Setting permissions

The final step in the publishing process is to set permissions for the presentation. This establishes who is able to view the presentation. You have a several options available.

**To set permissions for the presentation.**

1. In the Set Permissions dialog box, select a permission setting.

   - The default permission setting is Same as Parent Folder. If you select this option, the presentation automatically inherits the same permission profile as the parent folder in which it's published. For example, if the parent folder has permission for public viewing, the presentation will also have permission for public viewing.

   - To change the permission setting, click Customize. To create a public presentation, select Yes next to the Allow Public Viewing option. To create a private presentation with a custom permission profile that is different from that of its parent folder, make sure the Allow Public Viewing option is not selected. Then, create a list of users and groups with specific permission types. In the Available Users and Groups list on the left, select a group or individual and click Add. The new user or group now appears in the Current Permissions list on the right. Continue adding or remove users or groups as necessary.

2. Click Finish.
3. A dialog box appears and confirms that the project was successfully published to the specified Breeze server. Click OK.

The Content Information dialog box appears. This screen lists important information about the presentation, including the URL for viewing. If you click the URL, the presentation is displayed and begins to play. To share the presentation with others, you can send them the URL by clicking E-mail Link, or by cutting and pasting the URL into an e-mail. (For users to view the presentation, the published presentation or the folder containing the presentation must have the correct permissions set.)

4. Click OK to complete the publishing process.

**Adding a Breeze Presenter presentation to a Breeze meeting**

Macromedia Breeze Presenter lets you create e-learning content and high-quality multimedia presentations containing slides, streaming audio, synchronized animation, and navigation controls rapidly using Microsoft PowerPoint as a base.

After you have published a Breeze Presenter presentation to Breeze, you can add the presentation to a Breeze meeting by bringing the presentation file into the meeting from the Content library or directly from your computer. When viewing the presentation in Breeze, you have complete control over the screen side, slide navigation, and audio.

**Note:** Macromedia recommends adding presentations to Breeze Meeting from the Content library. Presentations uploaded directly from your computer and into a Breeze Meeting do not support some Breeze Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter logos, and the Thumbnail pane are not displayed.

**Adding a presentation from the Content library to a Breeze meeting**

Adding a presentation to a Breeze meeting from the Content library is a good method to use if you publish all of your presentations to the library and manage them from that location. (You also have the option to add a presentation to a Breeze meeting directly from your computer.)

**To add a presentation from the Content library to a Breeze meeting**

1. Open your web browser and navigate to your Breeze server.
2. Log in using your login name and password.
3. Click the Meetings tab.
4. Select a meeting from the list.
5. Click Enter Meeting Room.
6. Select Pods menu > Share > Select from Content library.
7. Select the presentation and click Open.
8. The Breeze Presenter presentation appears in the Breeze meeting.
Adding a presentation from your computer to a Breeze meeting

If you have a Breeze Presenter presentation stored on your computer, you can add the presentation directly from that location into a Breeze Meeting. This is a good method to use if you need to place a presentation into a Breeze meeting, but the presentation has not been published to the Content library. For example, you might have a presentation that you have not published because it is incomplete, but you want to show a preliminary version in Breeze Meeting.

Note: Macromedia recommends adding presentations to Breeze Meeting from the Content library. Presentations uploaded directly from your computer and into a Breeze Meeting do not support some Breeze Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter logos, and the Thumbnail pane are not displayed.

There are two methods for adding a presentation from your computer to a Breeze meeting.

To add a zipped presentation from your computer to a Breeze meeting

1. In Breeze Presenter, publish your presentation locally and select the Zip files Output Option. (To do this, click the Breeze menu, select Publish, click My Computer, select the Zip file option, and click Publish.)
2. Open your web browser and navigate to your Breeze server.
3. Log in using your login name and password.
4. Click the Meetings tab.
5. Select a meeting.
6. Click Enter Meeting Room.
   The Breeze Meeting appears.
7. From Share pod, select Documents > Select from My Computer.
8. Navigate to the presentation folder on your computer.
9. Select the presentation zip file and click Open.
10. The Breeze Presenter presentation appears in the Breeze meeting.

To add a presentation PowerPoint (PPT) file from your computer to a Breeze meeting

1. Open your web browser and navigate to your Breeze server.
2. Log in using your login name and password.
3. Click the Meetings tab.
4. Select a meeting.
5. Click Enter Meeting Room.
   The Breeze Meeting appears.
6. From Share pod, select Documents > Select from My Computer.
7. Navigate to the presentation PowerPoint (PPT) file.
8. Select the PPT file and click Open.
9. The Breeze Presenter presentation appears in the Breeze meeting.
Viewing a presentation in a Breeze meeting

After you publish a presentation to a Breeze server and then add the presentation to a Breeze meeting, the presentation is ready to view. All of the features in the presentation, such as audio, synchronized animation, quizzes, and presenter information, appear.

**Note:** If you upload your presentations directly from your computer and into a Breeze meeting, some Breeze Presenter presentation features, such as presenter photos and presenter logos, are not supported. Macromedia recommends adding presentations to Breeze Meeting from the Content library.

The presentation can be used as a static click-through, as supported in Breeze 4.1, or as a self-running, rich-media presentation. If the presentation contains quiz or survey questions, user interactions with the questions are fully tracked by the Breeze server as part of the meeting's reports. The following topics are discussed in this section:

- “Breeze presentation layout” on page 91
- “Using the presentation Outline pane” on page 92
- “Using the presentation Thumb pane” on page 93
- “Viewing presentation slide notes” on page 93
- “Using the presentation search feature” on page 94
- “Using the presentation toolbar” on page 95
- “Changing to full-screen viewing mode” on page 95
- “Navigating between slides” on page 96
- “Navigating within the current slide” on page 96
- “Adjusting the presentation audio” on page 97

**Breeze presentation layout**

The layout of a Breeze Presentation consists of the following parts:

**Presentation**  The main part of the window, which displays the presentation slides.

**Presentation sidebar**  An area on the right side (default location) of the browser window that shows the name of the presentation, the presenter information, and the Outline, Thumb, Notes, and Search panes (if you have added the panes to your theme).
**Presentation toolbar**  A control bar at the bottom of the presentation, which gives you control over the presentation playback, audio, attachments, and screen size.

![Presentation toolbar image](image)

*This published presentation includes the sidebar with panes on the right and the toolbar on the bottom.*

**Using the presentation Outline pane**

Most presentations have an Outline pane on the sidebar. The Outline pane lists the title and duration of each slide. You can use the Outline pane to display information and to move to a specific slide in the presentation.

**To view the Outline pane:**

- Click the Outline pane in the sidebar on the right side.

  The Outline pane contains the following features:

  - The current slide is highlighted with a glow color. (This color can be changed in the theme.)
  - The entire slide title appears when the pointer is held over the title.
  - The duration of the slide is shown next to each slide.
You can move to any slide in the presentation by clicking the slide title in the Outline pane.

The Outline pane lists the title and duration of each slide. Users can click on a title to display the slide.

Using the presentation Thumb pane

Presentations can have a Thumb pane on the sidebar. The Thumb pane shows a small picture of each slide, the slide title, and the slide duration. You can use the Thumb pane to see the contents each slide quickly and to move to a specific slide in the presentation.

Note: If you upload your presentations directly from your computer and into a Breeze meeting, the Thumb pane is not displayed. Macromedia recommends adding presentations to Breeze Meeting from the Content library.

To view the Thumb pane:
- Click the Thumb pane in the sidebar on the right side.

The Thumb pane contains the following features:
- The current slide is highlighted with a glow color. (This color can be changed in the theme.)
- The entire slide title appears when the pointer is held over the title.
- You can move to any slide in the presentation by clicking the slide title in the Thumb pane.

Viewing presentation slide notes

When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they can be displayed in the Breeze Presentation.

Note: Using slide notes is optional.
When slide notes appear, they are located on the right side of the presentation window. You cannot change the size of the slide Notes pane.

**To view slide notes:**
- Click the Notes pane in the sidebar on the right side.

  The Notes pane contains the following features:
  - The complete notes text is displayed. (The text is unformatted and cannot be edited directly on the pane.)

**Using the presentation search feature**

Users can use the Search pane (if you have included it in your theme) to find specific text in a presentation. For example, in a presentation that serves as a company human resources handbook, a user might search for the word *vacation* to find text about vacation leave policies.

**To view and use the Search pane:**
1. Click the Search pane in the sidebar on the right side.
2. Type the text to search for directly into the text box.
3. Click the Search button.

Search results are displayed below the text box. Click any slide title in the results list to display that slide.

*In this example, the user has searched for the term “OSHA” and received four results.*
Using the presentation toolbar

You can control the presentation appearance and playback by using the toolbar located at the bottom of the presentation.

The toolbar that appears in the published presentation contains useful buttons, controls, and messages.

The presentation toolbar includes the following items:

- **Play/Pause button** lets you pause and then resume play of the current slide.
- **Back button** lets you move to the previous slide in the presentation.
- **Forward button** lets you move to the next slide in the presentation.
- **Slide progress bar** shows and controls the playback location within the current slide. The position marker moves as the slide plays. You can drag the marker arrow forward or back in the current slide to change your location within the slide playback. You can also click a specific location on the progress bar to move the slide marker position and slide playback to that position.
- **Current slide number** shows the slide number of the currently displayed slide and the total number of slides (for example, Slide 2 out of 10).
- **Status** shows the status of the current slide, such as Playing, Stopped, No audio, or Presentation complete.
- **Time** shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).
- **Audio volume** shows the volume level that is set for the slide.
- **Attachments** displays a small window showing any attachments (for example, documents, spreadsheets, images, URL addresses, and so on) that have been added.
- **Show/Hide sidebar and toolbar** toggles between showing and hiding the sidebar and toolbar.

Changing to full-screen viewing mode

You can view Breeze Presentations in two modes:

- **Normal** is the default viewing mode. It includes the presentation toolbar at the bottom of the browser window and the presentation sidebar.
- **Full-screen** is an optional viewing mode in which the presentation toolbar is removed and the size of the presentation slides increases to fill your browser window.

**To toggle between viewing modes:**

1. Click the Full Screen button at the bottom of the Breeze Presenter viewer.

   If the presentation outline was originally visible, the Breeze Presentation switches to full-screen mode without a presentation sidebar. If a presentation outline is not originally visible, the Breeze Presentation switches to full-screen mode with no toolbar.
2. Click the Full Screen button again to change viewing modes.
   If presentation controls are originally visible, the Breeze presentation switches to full-screen
   mode without a presentation outline or presentation toolbar. If a presentation toolbar is not
   originally visible, the Breeze presentation switches to normal viewing mode with or without a
   presentation outline.

Navigating between slides
You can navigate between slides during playback by using either the presentation toolbar, or the
presentation Outline or Thumb pane.

   \textit{Note:} The Outline pane and Thumb pane are optional. Set panes for presentations using the
   Theme Editor in Breeze Presenter.

   \textbf{To move to the previous slide by using the presentation toolbar:}
   \begin{itemize}
   \item Click the Previous slide button in the presentation toolbar.
   \end{itemize}

   \textbf{To move to the next slide by using the presentation toolbar:}
   \begin{itemize}
   \item Click the Next slide button in the presentation toolbar.
   \end{itemize}

   \textbf{To move to the next slide by using the presentation Outline or Thumb pane:}
   \begin{itemize}
   \item Click the title of a slide in the presentation Outline or Thumb pane.
   \end{itemize}

Navigating within the current slide
You can control the following options from within a slide:

   \begin{itemize}
   \item Pause and resume slide playback.
   \item Move to a specific location in the slide playback.
   \item Move backward in the slide playback.
   \end{itemize}

   \textbf{To pause slide playback:}
   \begin{itemize}
   \item Click the Pause button on the presentation toolbar.
   \end{itemize}
   The button changes from Pause to Play.

   \textbf{To resume slide playback:}
   \begin{itemize}
   \item Click the Play button on the presentation toolbar.
   \end{itemize}
   The button changes from Play to Pause.

   \textbf{To move to a specific location in the slide playback:}
   \begin{itemize}
   \item On the presentation toolbar, do one of the following:
     \begin{itemize}
     \item Click a specific location on the slide progress bar to move the slide playback to that position.
     \item Drag the position marker arrow on the slide progress bar forward or backward to change
     your location within the slide’s playback.
     \end{itemize}
   \end{itemize}
To move to a specific location in the slide playback:
1. Click the slide playback Back button on the slide progress bar to move your playback location backward by a specific amount.
2. Click the Back button multiple times to continue moving farther back in the slide playback.

Adjusting the presentation audio

You can turn the presentation audio on and off by using the audio button on the presentation toolbar.

*Note:* Not all slides or presentations contain audio.

If a slide does not have any audio, the text *No audio* appears as the slide status on the slide progress bar. The slide still has an audio length and appears for that period of time before the next slide appears. This time is set by the presentation speaker.

To mute the audio:
- Click the Audio button in the presentation toolbar and move the volume bar to the bottom.

To enable the audio:
- Click the Audio button on the presentation toolbar and move the volume bar up increase the volume.

Viewing a presentation in Breeze Training

You can use Breeze Presenter presentations within Breeze Training courses. This enables you to quickly create e-Learning courses for formal assessments, compliance training, or information sharing. The new curriculum feature allows you to make your presentations part of a learning path. Quiz and survey results are tracked on a user-by-user and question-by-question basis. The results data can be viewed in Breeze Training reports.

Using presentations with Breeze Events

Breeze Events is a new application that provides tools to manage the full cycle of an event, from registration and qualification of users to post event follow-up. The Breeze Event dashboard and reports include user demographic information, registration, and tracking at the individual user level. Breeze generate exportable files in CSV format for import into CRM and other systems.

*Note:* If you want to use an existing Breeze Presenter presentation as an event, it is important to rename the presentation and republish the presentation to a different location and different folder in the Breeze Content library. This ensures that reporting information for the event does not include reporting information from prior events.

For more information, see the *Breeze Manager User Guide.*
Using presentations with third-party learning management systems (LMS)

Breeze Presenter lets you use presentations with any SCORM or AICC compliant LMS. Use the Reporting tab in the Breeze Presenter Quiz Manager to choose the correct reporting settings for the LMS and to create a content package that can be uploaded to the LMS.
This chapter describes two problems you may encounter when using Macromedia Breeze Presenter, and offers possible solutions.

This chapter covers the following topics:

• “Optimizing Flash (SWF) files”
• “Controlling inserted SWF files”

**Optimizing Flash (SWF) files**

Each slide in a presentation is loaded as an individual external Macromedia Flash asset and can be augmented with any SWF file. When working with embedded SWF files, follow these guidelines:

• Author the Flash SWF file at 30 frames per second. Breeze Presenter presentations are created at 30 frames per second, so Flash files with the same setting can be integrated into the presentation smoothly.
• In Flash, set the maximum canvas size to 720 x 540 pixels.
• Don’t use _root or absolute movie clip references. Use relative paths in the MovieClip object references, not _root.
• The SWF file you want to embed must not attempt to make any changes outside its own file. Therefore, the code cannot refer to the following variables: _level, _global, or stage.

**Controlling inserted SWF files**

If you added a SWF file to a presentation, but are having trouble using the Breeze Presenter playbar (Stop, Pause, Play, or other buttons) to control the SWF file in the viewer, you may need to change a setting.

**To specify how an inserted SWF file is controlled:**

1. In PowerPoint, open a presentation (PPT file) that contains an added SWF file.
2. From the Breeze menu, select Presentation Settings.
3. Click the Flash Files tab.
4. Select one of the Flash files in the list.
5. Select the Controlled by Presentation Playbar option.
   You will now be able to control the selected Flash file by using the Breeze Presenter playbar in the published presentation.

6. Click OK.
INDEX

A
AICC 41, 61
animations
  adding 26, 27
  audio synchronizing 26
  pausing 26
  PowerPoint 13
attachments
  about 23
  adding 23
  deleting 25
  editing 25
audio
  about 29
  adding existing 30
  animation synchronizing 26
  editing 37, 38
  headphones 30
  microphones 30, 32
  muting 97
  preamplifiers 30
  previewing 40
  quality 39
  recording 34
  recording equipment 30
  scripts 13
  silence 35
  timing 38
  volume 36, 97
auto-playing presentations 80

B
background, presentations 76
branching quizzes 43
Breeze
  about 8
  Content library 89
  presentation toolbar in 95
  searching presentations in 94
  viewing presentations full-screen 95
  viewing presentations in 91
Breeze Events 97
Breeze meetings 89
Breeze servers
  accessing 84
  logging in to 87
  manifest file 65
  permissions 88
  presentation information 88
  publishing list 84
  publishing location 87
  publishing presentations to 86
  selecting 86
Breeze Training 97

C
calibrating microphones 33
Captivate files 27
closing slides 13
colors in themes 72
connection speed 13
Content Library (Breeze) 89
contingency branching 43
controlling the playbar 28, 99
copyright slide 13
customer support 84

designing presentations 13, 69
documentation for Breeze Presenter 9
documents, attaching 24
E
e-learning. See Quizzes
editing presentations 17
environment, Breeze Presenter 11
escape characters, learning management systems 67
escape version, learning management systems 67
Excel spreadsheets 24

F
features, Breeze Presenter 7
feedback messages 64
fill-in-the-blank questions 50
Flash (SWF) files
   adding 26, 27
   optimizing 99
   playbar control 28, 99
FLV files 20
full-screen viewing 75, 95

G
Go to Side option 19

H
headphones, recording audio with 30
help, for Breeze Presenter 9

I
images
   adding 26
   quality 28
installing Breeze Presenter 10

J
jumping to slides 19

L
learning management systems
   customizing settings 63, 67
   manifest files 66
   presentations 98
   selecting in Breeze Presenter 62
likert questions 59
line-in audio recording 33
LMS. See Learning Management Systems
logos, adding to presentations 77
looping presentations 81

M
Macromedia Breeze Resource Center 9
manifest files 65
manuals for Breeze Presenter 9
master slides 42
matching questions 56
microphones
   about 30
   calibrating 33
   setting as input source 33
Microsoft Excel spreadsheets 24
Microsoft Word documents 24
MP3 files 29
multiple-choice questions 45
music. See Audio
muting audio 97

N
narration. See Audio
navigation name, slide 19
notes, slide 34, 78

O
online help for Breeze Presenter 9
opening slides 13
outline pane 19

P
panes (theme)
   default 73
   displaying 73
pass rate, in quizzes 63
PDF files, attaching 24
permissions on Breeze servers 88
planning presentations 12
PowerPoint
   animations 13
   importing scripts from Presenter 35
   Presenter within 5
   slide notes 34, 78
   templates in Presenter 76
preamplifiers 30
presentations
   advancing by user 21
   animations 26
   attachments, adding to 23
   audio muting 97
   background 76
   Breeze meetings 89
creating 12, 14
designing 13, 69
editing 17
full-screen option 75
image quality 28
logos 77
looping 81
Outline pane 92
planning 12
playing automatically 80
previewing 14
publishing to Breeze 86
searching in 94
starting 80
storyboarding 12
summary 17
themes 69
timing 81
title 17		
toolbar 95
types 6
viewing 14
viewing in Breeze 91
viewing in Breeze Meeting 91
presenters
about 21
adding 21
assigning to slides 22
deleting 23
editing 23
previewing
audio 40
presentations 14
properties, slides 19
publishing
Breeze servers list 84
locally 14
to Breeze servers 86

Q
quality
audio 30
image 28
questions. See Quizzes
quizzes
about 41
AICC 61
branching 43
creating 42, 44
deleting question slides 61
feedback messages 64
fill-in-the-blank 50
likert 59
manifest file 65
matching 56
messages 64
multiple choice 45
output options 61
pass rate 63
questions 42, 43
rating scale 59
reporting scores 62
scoring display 64
SCORM 61
short answer 53
slide order 61
tips for creating 43
ture or false 47
R
rating scale questions 59
recording audio
  calibrating microphones 33
  equipment 30
  input source 33
  options 32
  procedure 34
  software 31
  tips 31
requirements, system 9
Resource Center, Breeze 9
resources, Breeze Presenter 9
resume data, learning management systems 67
S
SCORM 41, 61
scripts
  audio 13
  exporting to PowerPoint 35
searching in presentations 94
session ID, learning management systems 67
short answer questions 53
sidebar
  colors 72
  navigation name 19
  panes 73
  showing and hiding in theme 75
  slide notes 78
theme location  74
video files  20
skipping slides  19
slide notes  34, 78
slide notes, viewing in a presentation  93
slides
  advancing by user  21
  background  76
closing  13
copyright  13
deleting  61
jumping  19
navigating in viewer  96
navigation name  19
opening  13
order  61
presenters  22
properties  18
skipping  19
timing  81
title  13
video  20
viewing properties  19
sound cards  31
sound effects  29
sound. See Audio
speaker. See Presenter
speakers (sound)  30
spreadsheets, attaching  24
storyboarding  12
summary, presentation  17
support  84
SWF files
  adding  20, 26, 27
  optimizing  99
  playbar control  28, 99
system requirements  9

T
talking head video  20, 35
technical support  84
text files, attaching  24
themes
  about  69
  colors  72
custom  70
deleting  72
full-screen option  75
panes  73
presenter options  76
selected  70
sidebar location  74
text labels  71
Thumb pane  19, 93
timing
  audio and animations  26
  slides  81
title slide  13
title, presentation  17
toolbar
  about  95
  colors  72
  pausing after animations  26
  playing presentations  80
  showing and hiding in theme  75
troubleshooting
  controlling inserted SWF file  99
  optimizing SWF files  99
true or false questions  47

U
URL links, attaching  24

V
video, adding  20
viewer
  navigating slides  96
  Outline pane  92
  search pane  94
  sidebar  91
  slide notes  93
  thumbnails  93
viewing presentations in full-screen mode  95
volume, changing audio  36

W
WAV files  29
websites, support for Breeze  84
Word documents  24
workspace  11